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Safety Guidelines

This manual contains notices which you should observe to ensure your own personal safety, as well as to
protect the product and connected equipment. These notices are highlighted in the manual by a warning
triangle and are marked as follows according to the level of danger:

Danger

/N

not taken.

indicates that death, severe personal injury or substantial property damage will result if proper precautions are

Warning

/N

not taken.

indicates that death, severe personal injury or substantial property damage can result if proper precautions are

Caution

/N

indicates that minor personal injury or property damage can result if proper precautions are not taken.

Note

draws your attention to particularly important information on the product, handling the
product, or to a particular part of the documentation.

Qualified Personnel

Only qualified personnel should be allowed to install and work on this equipment. Qualified persons are defi-
ned as persons who are authorized to commission, to ground, and to tag circuits, equipment, and systems in
accordance with established safety practices and standards.

Correct Usage

Warning

Note the following

This device and its components may only be used for the applications described in the catalog or the technical

description, and only in connection with devices or components from other manufacturers which have been

approved or recommended by Siemens.

This product can only function correctly and safely if it is transported, stored, set up, and installed correctly,
and operated and maintained as recommended.

Trademarks
SIMATIC , SIMATIC HMI

and SIMATIC NET are registered trademarks of SIEMENS AG.

Third parties using for their own purpose any other names in this document which refer to trademarks might
infringe upon the rights of the trademark owners.

Copyright Siemens AG 1999/2000 All rights reserved
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Preface

Purpose

This manual supports you when using the communication services provided by the
SIMATIC NET communications processors (Industrial Ethernet CPs) for
communication on SIMATIC NET with Industrial Ethernet in the management and
cell areas.

The manual contains information about the following topics:
e The performance and areas of application of the communication services
e Configuring the CP with the NCM S7 configuration software

e Programming the communication interfaces to the user program

Audience

This manual is intended for personnel responsible for installing and programming
STEP 7 programs and for service personnel.

Scope of this Manual

This manual applies to version 5.x and higher of the NCM S7 configuration
software and to version 5.x and higher of the STEP 7 software.

&
o3
\}
\(\’{(\ This version of the manual includes information relating to new functions since
A\ service pack 3 of STEP 7 and NCM S7.
(& In the main, this involves the following topics:

e The FETCH/WRITE mode is now supported on TCP connections. See
Chapter 4.

e The FETCH/WRITE mode can be coordinated in the user program by the new
FCs AG_LOCK and AG_UNLOCK. See Chapter 5.

¢ Using the FCs AG_FSEND and AG_FRECYV, you have blocks available that are
optimized for the SEND/RECEIVE interface with S7-400 stations.
See Chapter 5.

SIMATIC NET NCM S7 for Industrial Ethernet .
C79000-G8976-C129/04 I
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¢ NCM Diagnostics has a completely revised user interface. See Chapter 6

The description of NCM S7 Diagnostics has been restructured. While this
manual provides you with an overview and checklists, the online help provides
you with detailed information on the diagnostic events.

Additional Information

This manual is also part of the NCM S7 for Industrial Ethernet documentation
package. The following table provides you with an overview.

Title

Content

NCM S7 for Industrial
Ethernet
Primer

Based on simple examples, the primer introduces you to the methods of
connecting and networking SIMATIC S7 stations with CPs on Industrial
Ethernet. The primer shows you how the communications calls are entered in
the user program to allow you to use the services via the SEND/RECEIVE
interface.

You will learn how simple it is to create a configuration for standard
applications using STEP 7 and the NCM S7 optional package.

The examples described here can also be found in the project folder for
sample programs after you have installed STEP 7 and the NCM S7 for
Industrial Ethernet option!

NCM S7 for Industrial
Ethernet

The manual is intended as a guide and reference work for configuring and
programming an Industrial Ethernet CP.

Manual When working with the configuration software, you can also call up the online
help in specific situations.

IT-CP The manual is intended as a guide and sourece of reference when working

Manual with the IT-CP. In addition to the functions provided by an Ethernet CP, the

IT-CP also provides functions for Internet technology.

Product Information /
Manual for
Ethernet CP

The product information bulletins / manuals accompanying the CPs contain
information about the specific characteristics of the particular CP and
instructions on installation and connections.

Quick Start CD: Samples covering all aspects of communication

The Quick Start CD that can be ordered separately is a
treasure—trove of sample programs and configurations.

You can order this directly on the Internet at:
http://www.ad.siemens.de/net/html_00/online_zugreifen.htm

SIMATIC NET NCM S7 for Industrial Ethernet
C79000-G8976-C129/04
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Additional Information on SIMATIC S7 and STEP 7

The following documentation contains additional information about the STEP 7
standard software of the SIMATIC programmable controllers and can be obtained
from your local Siemens office.

Topic Document
Basic information for technical STEP 7 basics with
personnel using the STEP 7 ¢ Configuring hardware with STEP 7
standard software for control « p . ith STEP 7
tasks with S7—-300/400 rogramming wi
programmab|e controllers. *  Manual for COﬂVerting from S5 to S7

* Primer for a fast start

The reference works describing STEP 7 reference manuals with

the programming languages e Manuals for LAD/FBD/STL
LAD/FBD and STL as well as the
standard and system functions in
addition to the STEP 7 basic
knowledge.

® Standard and system functions for
S7-300/400

Access to Online Help of STEP 7 and NCM S7
With the online help, you can obtain the following information:
e Contents with the Help —> Contents menu command

¢ Context—sensitive help on the selected object using the Help —> Help menu
command, the F1 function key or the question mark in the toolbar.

You can then access further information relating to the current topic.
e Glossary for all STEP 7 applications by clicking the “Glossary” button.

Please note that each STEP 7 application has its own contents and
context—sensitive help.

Conventions

References to other manuals and documentation are indicated by numbers in
slashes /.../. These numbers refer to the titles of manuals listed in the References
section of the Appendix.

Tip:
This symbol appears in the margin to draw your attention to useful tips.

4

r
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Communication via Ethernet CPs in S7 1
Stations

The Ethernet CP for SIMATIC S7 provides a series of communications services for
different tasks.

This chapter explains the following:

Vi

The types of communication possible with the Ethernet CP on Industrial
Ethernet

The tasks handled by the Ethernet CP for the various services

How to create the conditions for your communications requirements

You will find further information in the following sources:

When installing the Ethernet CP, please refer to the instructions in the product
information /1/supplied with the Ethernet CP . This also contains further
information about the performance of the Ethernet CP .

For the functions and use of the STEP 7 configuration software, some of which
is used to configure the CP (such as hardware configuration), please refer to /5/
and /7/.

For using, structuring and handling Industrial Ethernet, you will find detailed
information in /10/.

For a general introduction to local area networks with TCP/IP refer to /15/ and
/16/.

SIMATIC NET NCM S7 for Industrial Ethernet
C79000-G8976-C129/04 1-1



Communication via Ethernet CPs in S7 Stations

1.1 Industrial Ethernet

Definition

Within the open, heterogeneous SIMATIC NET communication system, Industrial
Ethernet is the network for the management and cell level. Physically, Industrial
Ethernet is an electrical network that uses a shielded coaxial cable or twisted pair
or an optical network with fiber-optic cables.

Industrial Ethernet is defined by the international standard IEEE 802.3 (see /10/).

All-Round Communication in the Industrial Sector

Industrial Ethernet is integrated in the SIMATIC NET concept that allows
comprehensive networking of the management, cell and field levels in conjunction
with PROFIBUS and the AS-interface (AS-i).

Industrial

Ethernet
(IEEE 802.3)

PROFIBUS
(EN 50170 Vol. 2 PROFIBUS)

AS-Interface
(AS-i, Actuator-Sensor Interface)

Figure 1-1 Industrial Ethernet in the SIMATIC NET Concept

Network Access

Industrial Ethernet is accessed using the CSMA/CD (Carrier Sense Multiple
Access with Collision Detection) network access technique specified in
IEEE 802.3.

SIMATIC NET NCM S7 for Industrial Ethernet
1-2 C79000-G8976-C129/04



Communication via Ethernet CPs in S7 Stations

1.2 SIMATIC S7 Communication with S7 Ethernet CPs

Type of Communication

The Ethernet CP for SIMATIC S7 supports the following types of communication
depending on the CP type:

S7 — 400 Ethernet C Ethernet CP

1

Possible types of communication

* PG/OP communication S5-compatible HTML process
* S7 communication communication control with web
with the protocols with browser

- 1SO
— TCP/IP (RFC 1006)

File management
and file access
with FTP

SEND/RECEIVE FETCH/WRITE
interface services (server)

/ |

/ \

via connection types:

/ \

ISO-on-TCP
e TCP
UDP
E-mail:

® |SO Transport ® |SO Transport * |SO-on-TCP

e TCP

Figure 1-2  Types of Communication/Services of the Ethernet CP

¢ PG/OP Communication

PG/OP communication is used to download programs and configuration data,
to run test and diagnostic functions and operate and monitor a plant while
working at an OP.

SIMATIC NET NCM S7 for Industrial Ethernet
C79000-G8976-C129/04 1-3



Communication via Ethernet CPs in S7 Stations

S7 Communication

The S7 communication forms a simple and efficient interface between SIMATIC
S7 stations and PGs/PCs using communication function blocks.

S5-compatible communication

— SEND/RECEIVE
interface

Depending on the CP type, the SEND/RECEIVE interface allows
program-controlled communication on a configured connection from a
SIMATIC S7 PLC to another SIMATIC S7 PLC, to a SIMATIC S5 PLC, to
PCs/PGs, and to any other station.

— FETCH/WRITE services (server)

The FETCH/WRITE services (server) allow direct access to the system
memory areas on the SIMATIC S7 CPU from SIMATIC S5 or from devices
of other ranges.

HTML Process Control

With the IT-CP, you use the supplied functions and HTML pages to query
important system data using a web browser (refer to the IT-CP manual for more
information /4/).

File Management and File Access with FTP
The IT-CP (S7-400) provides additional function for FTP services.

You can use your S7 station both as an FTP client and as an FTP server (refer
to the manual of the IT-CP /4/).

— S7 Station as FTP Client
You can transfer data blocks from or to a file server.
— S7 Station as FTP Server

Another station, for example, a PC transfers data blocks to or from the S7
station the file system on the IT-CP.

Communication Services on the SEND/RECEIVE Interface

1-4

Depending on the CP type, the following communication services are available:

ISO Transport

optimized for top performance at the self-contained manufacturing level
TCP/IP for internetwork communication with

— 1S0O-on-TCP connections (RFC 1006)

— TCP connections

— UDP datagram service

Sending E-malil

— The controller is capable of sending messages triggered by process events
(refer to the IT-CP manual for details).

SIMATIC NET NCM S7 for Industrial Ethernet
C79000-G8976-C129/04



Communication via Ethernet CPs in S7 Stations

Possibilities for Communication between Types of Device

The possible communication available with the types of communication listed

above is shown in the following table:

5.7-300
i ‘l
[ |
3 00
L SEND/RECEIVE

S7 communication
S7/M7-400

u
N
i

SEND/RECEIVE

i
i

S7 communication

(S7-300 server only)

SEND/RECEIVE

S7 communication

SEND/RECEIVE

FTP services

Configuration and Diagnostics

S5-115 to —155U/H

SEND/RECEIVE

FETCH/WRITE

SEND/RECEIVE

FETCH/WRITE

I@I

PG/OP
communicationt)

S7 communication
SEND/RECEIVE

FETCH/WRITE

HTML process
control

PG/OP
communicationt)

S7 communication
SEND/RECEIVE

FETCH/WRITE

HTML process
control

FTP services

To connect and configure the Ethernet CP, you require the STEP 7 configuration
software and the SIMATIC NET NCM S7 for Industrial Ethernet option.

NCM S7 for Industrial Ethernet is installed as a STEP 7 option and is therefore

integrated in STEP 7.

NCM S7 for Industrial Ethernet also provides a wide range of diagnostic functions

for the various types of communication.

SIMATIC NET NCM S7 for Industrial Ethernet
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Communication via Ethernet CPs in S7 Stations

1.3 PG/OP Communication via Industrial Ethernet

Application

PG/OP communication provides functions that are already integrated in every
SIMATIC S7/M7/C7 device.

A distinction must be made between the following two types of function:
e PG Operation
PG operation with STEP 7 PLCs on Industrial Ethernet means the following:

— You can use the complete range of functions of STEP 7 on Industrial
Ethernet.

— You can use programming, diagnostic, operating and monitoring functions on
all modules in the SIMATIC S7 PLC via Industrial Ethernet.

e OP Operation

PG/OP communication on Industrial Ethernet allows the operation and
monitoring of all modules in a SIMATIC S7 PLC using operator interface
systems (TD/OP).

The Ethernet CP acts as a “communications relay” that relays the PG/OP
communication via Industrial Ethernet.

SIMATIC NET NCM S7 for Industrial Ethernet
1-6 C79000-G8976-C129/04



Communication via Ethernet CPs in S7 Stations

Operator Inter

face functions

EE[E=[=[==]=]
oooooooo | |-

Ethernet attachment

Create configuration data for
every CP and download to the
Ethernet CPs

Ethernet

S7-300 @
JN |

[
d
'

WAN *

* only TCR/AP

H

Ethernet CP

Ethernet CP

Figure 1-3  Configuration for PG/OP Operation

SIMATIC NET NCM S7 for Industrial Ethernet
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Communication via Ethernet CPs in S7 Stations

1.3.1 Using a PG with STEP 7 on Industrial Ethernet

Requirement for PG Operation
PG operation is possible when the following requirements are met:
¢ An Ethernet CP must be installed on the PG.

¢ The Ethernet CP has been assigned an address (node initialization).

Networking the PG
To be able to use a PG on Industrial Ethernet, follow the steps outlined below:

1. Connect the SIMATIC S7 stations you want to reach with the programming
device to Industrial Ethernet.

2. Configure the stations via the MPI interface so that the hardware configuration
and the networking parameters are loaded. Follow the instructions in Section
2.2 to network the Ethernet CP.

The minimum requirements for operation on Industrial Ethernet are that the
MAC/Internet address is set; this is known as node initialization.

1. Open the “Set PG/PC Interface” dialog box in the Windows Control Panel.

2. Set the PG/PC interface according to the CPs available on your PG and
according to the bus attachment (interface parameter assignment used).

For more detailed information, refer to the integrated help system.

After you have worked through these steps, the PG (STEP 7) automatically finds
the path to all intelligent modules in your SIMATIC S7 station via Industrial
Ethernet.

SIMATIC NET NCM S7 for Industrial Ethernet
1-8 C79000-G8976-C129/04



Communication via Ethernet CPs in S7 Stations

1.3.2 OP Operation: Connecting Operator Interface Devices via
Industrial Ethernet

Requirements

Operation allowing operator interface functions is possible when the following
conditions are met:

e The operator interface device has:
— an Ethernet CP installed

— SOFTNET S7 for Industrial Ethernet or S7-1413/WIN 95, WIN NT, MS-DOS,
Windows installed

¢ The CPs in the S7 stations have a MAC/Internet address (node initialization;
see Section 1-11).

Procedure

To be able to use S7 communication, address the required module in the SIMATIC
S7 PLC on your operator interface system.

ﬂ For more detailed information, refer to the description of your operator interface
system.

SIMATIC NET NCM S7 for Industrial Ethernet
C79000-G8976-C129/04 1-9



Communication via Ethernet CPs in S7 Stations

1.4 S7 Communication on Industrial Ethernet

Application

S7 communication via Industrial Ethernet allows program-controlled
communication using communication SFBs/FBs and configured S7 connections.
Per job, up to 64 Kbytes of user data can be transmitted.

The CP acts as an “S7 communication relay” that passes on the S7 functions via
Industrial Ethernet (see /7/).

Stations for S7 Communication

The Ethernet CP supports S7 communication via Industrial Ethernet on the basis
of ISO transport and 1SO-on-TCP for:

e PC applications with an Ethernet CP and an interface to the SIMATIC S7 PLC
for operator intervention, monitoring and control;

e Communication between S7 stations with integrated communication SFBs/FBs.

s7—4oo S7-300  Ethernet cp2

WAN *

Ethernet

face functions

* only TCP/IP

M7

PG with Ethernet CP  PC with Ethernet CP

S7-400 ernet CP

Figure 1-4 ~ S7 Communication on Industrial Ethernet

SIMATIC NET NCM S7 for Industrial Ethernet
1-10 C79000-G8976-C129/04



Communication via Ethernet CPs in S7 Stations

Networking S7 Stations

Before you can use S7 communication, you must first network the S7 stations as
follows:

1. Attach the CPs of the SIMATIC S7 stations that you want to communicate with
to the Ethernet subnet using S7 functions.

2. Configure the stations via the MPI interface so that the hardware configuration
and the networking parameters are loaded. Follow the instructions in Section
2.2 to network the Ethernet CP.

The minimum requirements for operation on Industrial Ethernet are that the
MAC/Internet address is set; this is known as node initialization.

Communication in the User Program

You use SFBs (S7-400) in the user program; these system and standard functions
are described in detail in /8/.

Configuring Connections for S7 Stations

To use S7 communication for data exchange between two SIMATIC S7 stations,
use the connection configuration in STEP 7. For more detailed information, please
refer to the STEP 7 description /5/ /7].

Communication with a PC/PG via the S7 Interface — Procedure
PC operation is possible when the following conditions are met:
e The PC has:
— an Ethernet CP installed

— SOFTNET S7 for Industrial Ethernet or S7-1413/WIN 95, WIN NT, MS-DOS,
Windows is installed

¢ The CPs in the S7 stations have a MAC/Internet address (node initialization;
see page 1-11).
To use S7 communication with the SIMATIC S7 PLC from a PC, address the

required CPU module in the SIMATIC S7 PLC that you want to communicate
with in your PC application.

For more detailed information, refer to the manual of the Ethernet CP you are
using in the PC /11/.

SIMATIC NET NCM S7 for Industrial Ethernet
C79000-G8976-C129/04 1-11



Communication via Ethernet CPs in S7 Stations

1.5 S5-Compatible Communication (SEND/RECEIVE
Interface 1)
Application

Using the SEND/RECEIVE interface, your S7 user program has access to
S5-compatible communication with configured transport connections.

Data transmission on a configured transport connection is suitable for

¢ the reliable transmission of related blocks of data between two Ethernet nodes
using

— TCP (see /16//18//19/)) with ISO-on-TCP (see /17/) or TCP connection
— IS0 transport connection

¢ simple (unacknowldeged) transfer of related blocks of data (datagram service)
between two Ethernet nodes with UPD (User Datagram Protocol) on IP.

The SEND/RECEIVE interface is also suitable for sending E-mail (refer to the
manual for the IT-CP /4/).

For TCP applications, there is an active network with IP protocol (see /19/).

ISO Transport Connection

ISO transport provides services for the reliable transfer of data on configured
connections. Due to the segmentation of the data, large amounts of data can be
transmitted.

Transmission reliability is extremely high due to automatic repetition and additional
field check mechanisms. The communications partner confirms reception of data
and the sender receives a return value on the SEND/RECEIVE interface.

ISO transport is operated only on Industrial Ethernet and is optimized for
high-performance operation at the self-contained manufacturing level.

IP (Internet Protocol)

1-12

For internetwork data transmission, the following services are available with
suitable CPs such as the CP 443-1 TCP:

¢ |SO-on-TCP connection
ISO-on-TCP is intended for reliable, internetwork data transmission.

The 1SO-on-TCP service corresponds to the TCP/IP standard (Transmission
Control Protocol/Internet Protocol) with the RFC 1006 extension according to
layer 4 of the 1SO reference model (see /17/).

RFC 1006 extends the TCP protocol by allowing the transmission of blocks of
data (“messages”) assuming that both partners support RFC 1006.

Transmission reliability is extremely high due automatic repetition and additional

SIMATIC NET NCM S7 for Industrial Ethernet
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field check mechanisms. The communications partner confirms reception of
data and the sender receives a return value on the SEND/RECEIVE interface.

e TCP connection

When using the SEND/RECEIVE interface on TCP connections, the Ethernet
CP supports the socket interface (for example, Winsock.dll) to TCP/IP found on
almost every system (PC or other system).

TCP is intended for reliable internetwork data transmission.

The TCP service complies with the TCP/IP standard (Transmission Control
Protocol/Internet Protocol; see /17/).

e UDP connection
UDP is intended for simple internetwork data transmission without confirmation.

If the connection is suitably configured, broadcast frames can also be sent on
UDP connections.

SEND/RECEIVE
interface

Data transfer is triggered by the user program. The interface to the user program in
the SIMATIC S7 is formed by special SIMATIC S7 blocks of the type FC
(functions).

Stations

The SEND/RECEIVE interface allows program-controlled communication on
Industrial Ethernet between the SIMATIC S7 PLC and the following:

¢ SIMATIC S7 PLC with Ethernet CP
¢ SIMATIC S5 PLC with Ethernet CP
e PC/PG with Ethernet CP

e Other station with Industrial Ethernet attachment

1 The previous name of the SEND/RECEIVE interface was S5S5 connections

SIMATIC NET NCM S7 for Industrial Ethernet
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Ethernet
RURERRIAI
1RNEN
RUNINOR
[ 00 ]
SIMATIC S5 Other station with
with Ethernet CP Ethernet attachment PG/PC with Ethernet
attachment

e

WAN
Internet
Router

only TCP/IP
=

Figure 1-5  SIMATIC S7 PLC with Possible Communications Partners on the SEND/RECEIVE Interface
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1.6

FETCH/WRITE Services (Server)

Application

In addition to the SEND/RECEIVE interface, the FETCH/WRITE functionality
provides further services for S5-compatible communication on configured transport
connections.

The FETCH/WRITE interface is used primarily to attach SIMATIC S7 to SIMATIC
S5 and to other non-S7 stations (for example PCs).

v

FETCH

The partner on the connection (SIMATIC S5 or non-S7 station) can read
system data on the SIMATIC S7 PLC.

WRITE

The partner on the connection (SIMATIC S5 or non-S7 station) can write
system data on the SIMATIC S7 PLC.

From the point of view of the SIMATIC S7 PLC, this is a passive communication
function; the communications partner initiates the connection establishment.

For further information, refer to the system documentation of the SIMATIC S5 PLC
or the non-S7 station you are using.

Connection Types

To access a station with FETCH or WRITE functions, a FETCH passive or
WRITE passive connection must be configured. The following types are
possible:

ISO Transport
ISO-on-TCP
TCP

Coordinating Access Using the User Program
To coordinate access, you can use the FCs AG_LOCK and AG_UNLOCK.

SIMATIC S5

With these FCs, you can coordinate access to system memory areas so that no
inconsistent data are created and transferred.

On the SIMATIC S5 station, the FETCH/WRITE services are configured and
started by READ ACTIVE/PASSIVE and WRITE ACTIVE/PASSIVE.

SIMATIC NET NCM S7 for Industrial Ethernet
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1.7

Networking Stations with STEP 7

Configuring

Tools

Variants

To allow stations to communicate with each other the networks must be configured
in the STEP 7 projects.

Configuring a network or subnet involves the following:
1. You create one or more subnets of the required subnet type in the project.

2. You select the properties of the subnet. Normally the default settings are
adequate.

3. You connect the station “logically” to the subnet.

4. You set up connections for communication.

The SIMATIC Manager provides convenient tools for configuring and documenting
networks (also graphically with NetPro).

%NETPHD: Configuring Metworks - [Metwork To Project "D:\siemens\S TEPF¥402\Examples\EXIE"]

Engﬂetwork Edt Inset PLC “iew DOptions Window Help

ES] wle) @ & @) Bl k2

Ethernet (171
Inclustrisl Ethernet

MiFI-Metz(1]
HFI

[SIMATIC 400-Station(1) [SIMATIC 400-Station(2)

[SIATIC 400-Station(3) —
g [SIMATIC =501
H]]]I R H]]II G |G H]]II i o
414|443 414 (443 443 ‘7-

[u] a [m] =] [=] o
2 2 2

The chapter describing network configuration in /5/ and the online help system also
contain information about configuring SIMATIC S7 networks.

Before configuring networks with STEP 7, you should be aware of the various
configurations possible in the STEP 7 project. The following configurations are
typical for stations networked with CPs:

Variant (examples)

Characteristics/Configuration

1 1 subnet — 1 project
2 Additional SIMATIC S5 stations and stations with equipment of other vendors
3 2 or more subnets — 1 project
SIMATIC NET NCM S7 for Industrial Ethernet
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Variant (examples)

Characteristics/Configuration

1 subnet — more than one project

4
5 More than one subnet — more than one project
6 Internetwork connections (ISO-on-TCP)

These variants will be used as a basis to illustrate how real configurations can be
created in STEP 7 projects.

SIMATIC NET NCM S7 for Industrial Ethernet
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1.7.1 Network/Project Variant: One Subnet — One Project

Configuration of the System

In the simplest case, your system consists of SIMATIC S7 stations connected by
one subnet, for example of the type Industrial Ethernet.

S7-400/1

S7-300/1

R

System
“Production” |
I

Ethernet (1)

S7-300/2

View in a STEP 7 Project

You create an Industrial Ethernet object in the STEP 7 project. Stations created
in the same project refer to this object as soon as they are configured as
network nodes.

HSIMATIC Manager - [Production - <Offline> [Project] — D:\siemens\STEP7¥402\57proj\Prod... =] B3

B File Edit lreett PLC “isw Optiors Swindow Help == x|

g = e = e B ™ T e
) e =

raduction

B SIMaTIC 40001]
IMATIC 300(1) SIMATIC4001]  SIMATIC300(1)  SIMATIC 300[2) MFI[1)
IMATIC 300(2]

%Eﬂetwork Edit Insert PLC “iew Options Window Help _|E'|5|
Ethermet(1] = = : =,
=R|a| e sl = 52| Bz
SIMATIC 40001 ) [SIMATIC 30001)
CRU[CR CRU[CP
!]]]I 413|443 Lo 13 [343
o= o (=
Ethernet(1) H 2
Industrial Ethernet l l

WAFICT )
MPI

[SIMATIC 30002)

CPU|CP

I]Iu 212|242
m} m

2 o

=
4] | >

Ready lilili i

Press F1 far help.
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1.7.2 Network/Project Variant: SIMATIC S5 and Non-SIMATIC Devices
on the Subnet

Configuration of the System

In addition to SIMATIC S7 stations, SIMATIC S5 stations and non-SIMATIC
devices can be included in your system.

S7-400/1
System S7-300/1

“Production” uﬂ‘ -] -]I] Non-SIMATIC
i -I]-

Ethernet (1)

-] -]l] AT T
-I]- R

S7-300/2 [ J0nooc ]

| SIMATIC S5

View in a STEP 7 Project
SIMATIC S5 stations you intend to include in the communication can be
selected directly. Non-SIMATIC devices must be entered in the configuration as
Other stations.

Egl SIMATIC Manager - [Production2 - <Offline> [Project] -- GAGDESKTOPYWNCMS7_stuf2. v41+ . [ B3

EP File Edit lnset PLC Wiew Options ‘Wwindow Help ETES]

D827 &[5 & 2™ [5. =

425§ ProductionZ

SIMATIC 40001) SIMATIC 20001) SIMATIC 300(2) Other Station(1]

=

MPIT] Ethernet{1] SIMATIC S5[1]

%gﬂelwork Edit Inzert PLC “iew Options “Window Help _|ﬁ||5|

=lE(e| fle] b 5 o]e] Bl wl|

SIMATIC 400017 [SIMATIC 300017 Other Station(1
m CRU[CF gl [crUlcE =

413 (43 313|343 [5]

o o
Ethirnet(1) ¥ 2
Inclustrial Ethernet l l

WFIC )
[l

SIATIC 300(2)

CPU|CP
i 213|242
] [=]
K

Presz F1 faor help.

Fieady | |
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1.7.3 Network/Project Variant: Two or More Subnets — One Project

Configuration of the System

Due to the different tasks of the stations or due to the extent of the system it may
be necessary to operate more than one network.

uﬂ‘ S7-400/1
1

System

Ethernet (1)
Ethernet CP
"Production and ;
Management Level” S7-400/2 u
I ROFIBUS CP

| 'PROFIBUS (1)

Eﬂé[l EIH![I

S7-300/1 S7-300/2

View in a STEP 7 Project

You can create the subnets in one STEP 7 project and configure the stations for
communication.

HSIMATIC Manager - [Production and Management - <Offline> [Project] - G:AGDESKTOPANCMS... =] [E3
% File Edit Inset PLC “iew Optionz ‘Window Help = |5’|£|

MR EET I I EE
E@ Production and Managemen
[ SIMATIC 40001)

-(ERI SIMATIC 400(2) SIMATIC 400(1)  SIMATIC400[Z]  SIMATIC 3000 SIMATIC 300(2)
- [f] SIMATIC 300(1)
G- SIMATIC 200(2)
MPI[1) Ethernet(1)
Press F1 for help. | | | y

This representation illustrates the following:
e More than one subnet can be managed in one project.
e Each station is created once in the project.

e Each station can be assigned to more than one subnet by assigning its CPs to
different subnets.

SIMATIC NET NCM S7 for Industrial Ethernet
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1.7.4 Network/Project Variant: One Subnet — More Than One Project

Configuration of the System

In complex networked systems, it maybe more practical to manage the stations in
more than one project.

System section
“Production 2"

System section p
"Production 1” H

I
u

S7 —400/2

S7 400/1

Ethernet (1)

L L L
S7300/1  S7-300/2 S7-300/3

View in a STEP 7 Project
To be able to address stations that are managed in a different project (production
2), these stations are configured additionally as “Other stations” (in the
project for production 1).

E2 Production_1 - <Offline> [Project] - G:AGDESKTOPANCMS7_stuf2 V41\Beispiele\Produc_2
- Production_1 T“‘ il

i j i
SIMATIC 400(1)  SIMATIC3001)  SIMATIC 300(2)

g T %

&1
Station(57-300/3)

(ther MPI[1) Ethemet(1]
Station[57-400/2)
E Production_2 - <Dffline> [Project] - G:AGDESKTOP\NCMS7_stuf2 V41\Beispiele\Produc_3 [_ (O] ]

[#-2% Production_2

(ther PI[T) Ethemet(1]
Station(57-40041]

This representation illustrates the following:

¢ A subnet can be assigned to several projects.

Note

S7 connections can only be configured within one project.

SIMATIC NET NCM S7 for Industrial Ethernet
C79000-G8976-C129/04 1-21



Communication via Ethernet CPs in S7 Stations

1.7.5 Network/Project Variant: Two or More Subnets in More Than
One Project

Configuration of the System

If the different tasks of the stations or the extent of the system mean that different
network types are necessary and that the network types must be managed in
different projects, the stations in a different project can once again be addressed
by configuring them as “Other stations”.

Ethernet (1) Coll level
ell leve

£ Cell_level - <Dffline> [Project) -- G:A\GDESKTOPANCHS7_stuf2.V41\Bei... [H[=] E3 I

Ethernet CP & Object Name Syre.. | Type
St i 400/1 SIMATIC 400(1) SIMATIC 40001 SIMATIC 400 Station
u % Other Station(57-30... - Other Station
| ROFIBUS CP B Other Station(57-30... Other Station

I TEMPI) - MAl

?PHDFIBUS[‘I] PROFIBUS
J ? Ethertet(1] Industrial Ethernet

Ll | i

yr

Field level

PROFIBUS (1)

EI]E[I EI]E[I

S7—-300/1 S7 — 300/

Z21 Field_level - <Offline> [Project] - G:\GDESKTOPANCMS?_stuf2.va1ie_.. [M[=IE3

EI@ Field_lewel Object Name Symb... | Type
E-{g] SIMATIC 300(1) SIMATIC 30001 SIMATIC 300 Station
-l SIMATIC 300(2) SIMATIC 300(2) SIMATIC 300 Station
5% Other Station(S7-40... - Otker Station
TEMPI) MPI
= PROFIBUS
4| 2
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1.7.6 Network/Project Variant: Connections between Subnets
(TCP/IP)

Configuration of the System

If connections are required to stations on network structures connected by routers
due to the differing tasks of the stations or the large span of the network, the
stations in the other project can be reached by configuring “Other Stations”.

S7-400/1

u Ethernet CP
Ml
[

Ethernet (1)

Router *

Ethernet (2)

S7 —-400/2 S7 4 300/1

N _ I[l ! II I]-l] * only TCP/IP
View in a STEP 7 Project

If the stations in the two networks are managed in the same project, the
networking appears as shown below in NetPro.

;_—‘;_%NETPHI]: Configuring Networks - [Metwork To Project "‘G:A\GDESKTOPANCMS7_stuf2 ¥41\Beispiele\Project_']

%@Hetwork Edit Inzet PFLC “iew Option: Window Help

slglal o] wl =) 51| @lsf

Ethernet (17
Industrial Ethernet
PAPI-Metz(1 )
TPl
m SIMATIC 400-Station(1) B for SIMATIC-400 Stat(2)
Marne: CP 443-1 TCF(E) =
Type: CF 4431 TCP
5 far SIMATIC-400 Stat(1) S T d00-Statlon(2)
“ g E]]]I 14 |44
O Im SIMATIC 30001
A CPUJCP
5 313 [343
(m] (=]
2
Ethernet(2)
Industrial Ethernet
|
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Installing and Starting the Ethernet CP 2
with STEP 7

To attach a SIMATIC station to Industrial Ethernet via the Ethernet CP, configure
the CP with the NCM S7 configuration software. The chapter explains the
following:

¢ How the CP is configured in the STEP 7 project

e How the various network configurations are managed (setting up access to
other systems)

e How to control and supply the CP with data using NCM S7

n You will find further information in the following sources:

¢ When installing the Ethernet CP, please refer to the instructions in the product
information / manual /1/ supplied with the Ethernet CP. This also contains
further information about the performance of the Ethernet CP .

e For more information about the functions and applications of STEP 7 in which
the NCM S7 option is integrated, please read the following topics:

— For using the help functions, read the section Working with STEP 7 in /5/.

— Configuring and assigning parameters to modules in /5/

— Configuring networks in /5/. You will find this information in the online help
h‘? with integrated in STEP 7 by selecting Help » Contents.

¢ You will find examples of configurations in the Primer /3/.

SIMATIC NET NCM S7 for Industrial Ethernet
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2.1 General Information About the NCM S7 for Industrial
Ethernet Option

Installation

Functions

Operation

2-2

Please follow the instructions in the README file when installing the NCM S7 for
Industrial Ethernet option on your PG/PC under STEP 7.

NCM S7 consists of the following:

CP-specific index dialogs that you call using the properties dialog box of the
modules.

Dialogs for the connection configuration
Diagnostic functions that you obtain as follows:
— Using the “Diagnostics” tab in the properties dialog

— Using the standard Start menu of Windows with which you can call the
SIMATIC program group

Functions displayed with SIMATIC » NCM... in the Start menu of Windows:

Diagnostics

Help for functions (FCs)

— “Readme” file with current information about NCM

Firmware loader

Operating and handling the software package is as explained in the STEP 7 user
manual /5/.

SIMATIC NET NCM S7 for Industrial Ethernet
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2.2 Procedure

A CP is managed in an S7 project just as the other modules. You use STEP 7 to
configure the hardware and create and manage the user software (see /5/).

Configuring a CP involves the following basic steps (the broken lines indicate
options):

Create the Industrial Ethernet subnet (see 2.2.1)

Enter the Ethernet CP in the hardware configuration
(see 2.2.2)

Attach the Ethernet CP to the Ethernet subnet
(see 2.2.2)

Program the SEND/RECEIVE interface (see |
Chapter 3)

Configuring communication services (see Chapter 4)
— S7 connections /5/

— ISO transport connections

— ISO-on-TCP connections

— TCP connections

— UDP

Configuration data in
the STEP 7 project

\

Download the configuration to the PLC (see 2.2.7).

The steps are explained in detail in the sections shown.

Fields with broken lines are optional.

SIMATIC NET NCM S7 for Industrial Ethernet
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221 Creating an Industrial Ethernet Subnet

Aims
To be able to attach the SIMATIC stations to a subnet, you create the subnet in

your project. This means that all the parameters for the entire subnet are managed
centrally.

Procedure

It is advisable to create the subnet before you configure the stations since the
assignment of the SIMATIC stations is then performed largely automatically.

It is also possible to create the subnet at a later point in time when configuring a
CP. This is explained in more detail later in the chapter.

Follow the steps outlined below:
1. Select the project in the SIMATIC Manager.
2. Select Insert » Subnet » Ethernet.

Result: An object of the type network is created in the project. This allows all
the SIMATIC stations created in the project to be attached to this subnet.

@Eile Edit Inset FELC “iew Options

M ERE I EE e R E

e B & &
Bl SIMATIC 400-Station(1)

-l SIMATIC AN0-Station(?) SIMATIC SIMATIC SIMATIC
-l SIMATIC 400-Station(3) 400-Station(1]  400-Station(?]  400-Statian(3)
MPLMNetz(1)  Ethernet(1)  SIMATIC S5(1)

N

Press F1 far help. [ [

Figure 2-1 Project with Assigned Ethernet Network

3. If you prefer a graphic network display, select the network object “Ethernet” and
confirm with Edit » Open Object.

SIMATIC NET NCM S7 for Industrial Ethernet
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E:!_%NETPHD: Configuring Metworks - [Network To Project "D:\siemens\S TEP7YV402\Examples\EXIE"]

%gﬂetwork Edit Inzert PLC “iew Option: “Window Help

@S| e dl == <P B8] |

Ethermet (171
Inclustrial Ethernet

MiP1-hetzi 1
hiP

[smaTIC 400-Station(l ) [SIMATIC 400-Station(2) [SiMATIC 400-Station(3)
H]]]I TRUCE H]]]I TRU[CE H]]]I TF

414|443 14 |44 443

o o o ln =

I

I

I

SIMATIC S501)
=

Figure 2-2  Graphic Network Representation (here showing stations not yet networked)

From this graphic representation, you can also activate all the functions for
networking and configuring connections with the Ethernet CPs.

SIMATIC NET NCM S7 for Industrial Ethernet
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2.2.2 Entering an Ethernet CP in the Hardware Configuration

Procedure

By inserting the Ethernet CP in the rack of a SIMATIC station and assigning it to
the station, you establish the logical attachment between the CP and subnet.

1. Select the station in your project that you want to attach to Industrial Ethernet
using an Ethernet CP.

2. Select the CP in the hardware configuration just like any other module by
selecting it in the hardware catalog and then selecting the slot in the rack.

You select CPs in the hardware catalog using a short text and the order
number. Once you have installed NCM S7, the CPs are available in the catalog.

Result: The CP is assigned to the SIMATIC station.

For information about the permitted slots, refer to /1/.

How to configure a module is described in detail in /5/.
Subnet Attachment

To allow you to activate the network attachment of the Ethernet CP, the SIMATIC
Manager displays the following dialog:

Froperties - CP 443-1 - [R0D/57) x|

General I.-’-‘n.ddressesl Dptionsl Diagnusticsl

J Properties - Ethernet interfface CP 443-1 [R0/57) |
General Parameters | .

MAL Address:

(" W IPErotocal is being used
!

Router
IP &ddress: |1 40.80.0.3 " Do not use rouker

Subnet Screen Form: |255.255.D.D

 Use router

Address: |1 40.80.0.3

Subnet:

--- rot networked --- MHew. ..

[
1 Froperties. .. | j
Delete |

abbrechen | Hife | [yop |

SIMATIC NET NCM S7 for Industrial Ethernet
2-6 C79000-G8976-C129/04



Installing and Starting the Ethernet CP with STEP 7

Note

You can open the dialog for setting the interface at any time from the Properties
dialog of the CP in the “General” tab.

3. If you have not yet created a subnet in the project or have not yet created the
selected subnet, you can now create a subnet. To do this, select the “New”
button.

Result: An object of the type network is created in the project.

4. Check the addresses and if necessary change them. The system enters the
next free address automatically.

5. Select the required subnet type in the “Subnet” list box.

6. You can display the properties dialog box for the selected subnet by clicking the
Properties button.

7. Enter information specific to the subnet node in the “General” tab.

8. You must finally confirm your input with OK, otherwise the networking is not
entered (refer to Point 5.).

Result: The CP is now configured as a network node for the corresponding S7
station.

Note

The input boxes “IP address” and “Subnet mask” are irrelevant for ISO transport.

SIMATIC NET NCM S7 for Industrial Ethernet
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2.2.3 Displaying the Network Attachments of a Station

Procedure

You can easily get an overview of the network attachment configurations of a
SIMATIC station in one of the following ways:

e A graphic overview in NetPro;

e An overview in table form in the Properties dialog of the station

Graphic Overview in NetPro
The NetPro view provides you with a good overview of the networked stations:
Follow the steps below:

1. Double-click one of the network objects, for example Ethernet in your project in
the SIMATIC Manager.

i—'&éNETPHD: Configuring Metworks - [Network To Project 'D:\ziemenzs\STEPTY402\Examples\EXIE']

%Qﬂetwork Edit |nsett PLC Yiew Options Window Help

SR8 (e @ = 5@ B8 x|

Ethernet (1)
Industrial Ethernet
PR I-Metz 1)
[
SIMATIC 400-Station(1) SIMATIC 400-Station(2) SIWATIC 400-Station3) SIMATIC 5501
H]II CPUJER H]II CPUCR H]]]I cP @
414|443 414 (443 443 =
0 = O = |s] -
B 2 B :

Figure 2-3 NetPro View of a Subnet of the Type Industrial Ethernet
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Overview in Table Form

The table view in the Properties dialog of the station provides a detailed overview
of the components used for network attachment.

Follow the steps below:

1. Using the SIMATIC Manager, select the station in your project that you want to
check.

2. Select the Object Properties using the menu option Edit » Object Properties
or by double-clicking the station symbol.

3. Select the “Interfaces” tab.

Result:
Properties - SIMATIC 400 Station
General Interfaces I Setting&l
Type I Address I Metwork I b oduile I Order Humber
P 2 CPU 41641 BESY 416-1:J01-04B0
Ind. Ethemet  140.80.04  Ethemet [1) CP 44311 BEET 443-1EX10-0ED
Ind. Ethemet  140.80.02  Ethemet [1) CP 4431 BEET 443-1EX02-0ED
P 2 CPU 416-1[1) BESY 416-1:J01-04B0
Ind. Ethemnet  08.00.06.0.. Ethemet [1) CP 4431 BGR(1) BEET 443-1BX00-0<EQ
ol |+
— Display interfaces by type ...
v MPI W EROFIBUS ¥ Industrial Ethernet v PIP

Cancel Help

Figure 2-4  “Interface” Tab in the “SIMATIC 300/400” Properties Dialog Box

In the displayed dialog, you can see the subnet attachments that were configured
for the SIMATIC station.

SIMATIC NET NCM S7 for Industrial Ethernet
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224 Setting Further CP Properties

Overview

In addition to the network attachment, you can also make further settings for the
specific module or you can call functions.

1. Select the Ethernet CP in the hardware configuration.

2. Select Edit » Object Properties. In the dialog, you will see further tabs in
addition to the “General” tab described in Section 2.2.2 depending on the type
and CP, some of which are shown in the example of a CP 443-1:

Properties - CP 443-1 - [R0/57) E
General |Addresses| Dptionsl Diagnosticsl
Short Designation: CP 4431
57 CP for Indugtrial Ethernet 150 and TCP/IP with SEND-RECEIVE and -
FETCH-WRITE Interface, long data, UDP. TCP, 57 functions, routing. module
replacement without PG
-]
Order Mo BGEY 443-1EX0Z-0<ED
Mame:
— Inkerface
Type: Ethemet
Address: 140.80.0.3
Metworked: Yes Froperties. ..
LComment:
=
Cancel | Help |

Figure 2-5 Example of the “General” Tab of the “Properties CP” Dialog Box for the CP 443-1 TCP

Please read the description of the Properties dialog of the CP in the integrated
help. The functions are explained in detail there.

Addresses Tab

The Addresses tab displays the address at which the module can be addressed by
the user program. You require this address when calling the FCs for transport
connections —> see Chapter 5.
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Options Tab

Depending on the CP type, you can make the following settings:

Table 2-1  Settings in the “Options” Tab

Option Meaning / Effect

* Time-of-Day Synchronization | Here, you decide whether the CP passes on time-of-day frames or
not. You require this function if you have several CPs in a station
since only one CP is permitted to pass on the time synchronization
messages.

Note

The time-of-day synchronization function does not exist for all module
types.

* Data transfer > 240 bytes With this option, you specify whether or not the CP will support jobs
with a data length of more than 240 bytes (for S7-300 stations).

Notes

* The transfer of more than 240 bytes of data is supported by
newer version CPs. Please note the information in the product
information bulletin / manual of the Ethernet CP.

* If you select this configuration for an S7-300, remember that a
connection resource (free connection for S7 Functions) of the
S7-300 CPU is used! CPU connection resources are also used,
for example, by S7-300 CPs, in the FMS mode or by PGs and
OPs. For more detailed information about the maximum
connection resources, refer to /12/ and /6/.

* Replace Module without PG With this option, you can have the configuration data of the CP stored
on the CPU. If you then replace CP, the configuration data for the
new CP are downloaded automatically from the CPU when the CP is
started up.

If you select this option, the configuration data are stored long-term
on the CPU instead of in the EEPROM of the CP. Remember,
however, that long-term storage on the CPU is only safe against
power failure if the CPU is battery backed or if you use an S7
memory card.

* Ethernet Profile for Select this profile if you use fault-tolerant communication in your

Fault-Tolerant Connections system. Fault-tolerant means that you have designed Industrial
Ethernet to include redundant components and that you have
configured fault-tolerant S7 connections.

If you select the Ethernet profile for fault—tolerant connections here,
the time response of the S7 connections is adapted. As a result,
breakdowns of a connection are detected more quickly and the
failover to redundant connections is faster.

Note

Select the Ethernet profile for fault—tolerant connections only when
you actually use fault—tolerant S7 connections. Otherwise you must
expect your system to be more susceptible to problems since, for
example, the number of transfer or connection establishment
attempts is reduced compared with non—-redundant systems.

SIMATIC NET NCM S7 for Industrial Ethernet
C79000-G8976-C129/04 2-11



Installing and Starting the Ethernet CP with STEP 7

Table 2-1  Settings in the “Options” Tab , continued

Option Meaning / Effect

* Individual Network Settings Here, you can make fixed network settings, when necessary. As
default, “Automatic Setting” is selected and this setting generally
guarantees problem—free communication in most situations.

If problems occur in communication (for example, when connections
are not established or when there are often disturbances on the
network), the reason may be that the selected or automatic network
settings are not suitable. You can then select a network setting to suit
your network configuration.

* Send Keepalives for Here, you can set the interval at which keepalives are sent to the
Connections partner of a communications connection. This setting decides the
latest time after which the failure of a communications partner is
detected.

For all connection—oriented services, the Ethernet CP is configured
so that keepalives are sent. This guarantees that connections are
closed if a communications partner fails and that the connection
resources are released. The setting made here applies to all TCP—
and ISO-on-TCP-connections operated via the CP; a
connection—oriented setting is not possible.

Possible values:

Default Setting: 30 seconds
Maximum value: 65535 seconds
Notes / Recommendations:

Remember that the keepalive mechanism can keep underlying
connections established (for example, an ISDN telephone
connection) although no user data are actually being transmitted. If
this is not required, set the interval so high that the underlying
connection is closed down when no further user data are sent before
a keepalive is sent.

Diagnostics Tab
In the “Diagnostics” tab, you can start NCM S7 Ethernet Diagnostics.

See Chapter 6 Diagnostics for a description of the diagnostic functions
themselves.

SIMATIC NET NCM S7 for Industrial Ethernet
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2.2.5 “Substitute Objects” in the STEP 7 Project

Overview

For the following stations on the Ethernet subnet, whose configuration data were
not created in STEP 7 or whose configuration data are not managed in the
currently active project, substitute objects must be created in the project:

e SIMATIC S5 stations

e Devices from other vendors (other stations)

« PG/PC

e SIMATIC S7 stations in a different project (other stations)

Note

Instead of creating substitute objects, you can also configure unspecified
connections for connections to the stations listed above.

In the Properties dialog of these connections, you must then specify the full
partner address. These partners do not appear in the NetPro plant view.

Plant Plant
"Production 1” "Production 2"

S7-400/1 S7-400/2
T
iy

Ethernet subnet (1)

u
N
I

S7-400/3

S7-400/4

u
Non-Siemeng I
1

device

R i !
gulil Rl E

[ JOi0oC 1 S7-400/5
SIMATIC S5
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Procedure

To enter a substitute object in the project, following the steps below:
1. Select the project in the SIMATIC Manager.

2. Select the menu command Insert » Station » and then as necessary
Other Station, PG/PC or SIMATIC Sb.

Possible result: the selected object is created in the project.

K SIMATIC Manager - [PROJECT-ETHERNET - <Standard Hierarchy. Of _ [H[=] E3
2 File

Edit Insert PLC Wiew Options

Window Help
O[] | & (B 2| 2al2 [== | = a2|
El@ PROJECT-ETHERMET =

o Jifl SIMATIC 400-Station(1) @ E

&1 ) SIMATIC 400-Station(2) SIMATIC SIMATIC SIMATIC
-l SIMATIC 400-Station(3) 400-Station(1)  400-Station(2) 400-Station(3)

ne
&

_1= x|

i

MPI-Metz(1) Ethernet (1)

SIMATIC S5(1)

Fress F1 far help.

Figure 2-6 Project With Substitute Objects Configured

Attaching Non-S7 Stations to the Subnet
The next step is to assign the substitute objects to the subnet, as follows:
1.

Select the required object in the project and select Edit » Object Properties.
2.

In the Properties dialog box that is displayed select the Interfaces tab and click
the “New” button (for example “Other Station”).

Result: The New Interface — Type Selection dialog box is displayed.

SIMATIC NET NCM S7 for Industrial Ethernet
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Properties - Other station E

General Interfacesl

M ame | Type | Address | Subnet |
Mew Interface - Type Selection E

Type:  FEthemetinterface.
IF interface

MP interface

PROFIBUS interface

FTP interface

Mew... [elEfe |
aK I Cancel Help |

QK. | Cancel | Help

Figure 2-7  Selecting the Subnet Type for “Other Station” (Example)

3. Select a subnet.

Result: The “Properties — Ethernet Interface” dialog is displayed. Here, you can
select the subnet, connect the station to the network and set the address (MAC,
IP). All the SIMATIC stations in the project can establish communication
relationships to this substitute object.

The addresses (MAP/IP) configured for the substitute object here must also be set
on the station using the appropriate tool, for example COM 1430.
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2.2.6

Configuring Communication Services

Setting Up Connections

2-16

You must set up connections for the connection-oriented services supported by the
Industrial Ethernet CP, see also the Table in Section 1.2.

S7 connections
see the STEP 7 user manual /5/

ISO transport connections
see Section 4.4

ISO-on-TCP connections
see Chapter 4.5.

TCP connections
see Section 4.6

Connections for UDP
see Section 4.7.

The information in the STEP 7 user manual /5/ in the chapter “Creating
Communication Connections Between Two Programmable Modules” also applies
to the additional types of connection possible with the CPs.

You will find this information in the online help with integrated in STEP 7 by
selecting Help » Contents. Select the topic “Configuring Connections and Data
Exchange.
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2.2.7

Principle

Downloading the Configuration to the PLC

The configuration data of the Ethernet CP are downloaded from the hardware
configuration. All the configuration data of the S7 station are downloaded including
the central configuration, all relevant DP master systems and all parameter
settings.

The data of the configured connections must also be downloaded, see below.

Type of Interface

Procedure

You can download the configuration data to the S7 station on the following paths
(interfaces):

* MPI interface

You always use this attachment when you download the configuration data for
the first time (node initialization).

During the so-called “node initialization”, you supply the Ethernet CP with a
MAC or Internet address. You will have configured the CP so that further
configuration is possible working on the PG connected to the Ethernet. Node
initialization is only possible via MPI.

¢ |ndustrial Ethernet

Here, you use the PG mode of the Ethernet CP in the S7 station (see also
Section 1.3). The node must previously have been initialized via the MPI
attachment.

To download the configuration data to the S7 station, follow the steps outlined
below:

1. Open the “Set PG/PC Interface” dialog box in the Windows Control Panel.

2. Set the PG/PC interface according to the CPs available on your PG and
according to the bus attachment (interface parameter assignment used).

For more detailed information, refer to the integrated help system.

3. Change the CPU to the STOP mode (regardless of the type of interface — see
above).

4. Select the menu command PLC » Download to Module.

STEP 7 then guides you through dialog boxes. Note the additional information in
the “STEP 7 User Manual”, Chapter “Configuring and Assigning Parameters to
Modules” /5/.

SIMATIC NET NCM S7 for Industrial Ethernet
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Saving the Configuration Data in Non-Volatile Memory

You can download the configuration data step-by-step or all at once. If you
download step-by-step, you will be prompted to start the download function
separately for each module. You must select this method if you want to save the
configuration data in non-volatile memory on the Ethernet CP. In this case, select
the “Copy to ROM” button in the “Download” dialog for the CP.

Downloading the Configured Connections

To download configured connections, you use a corresponding download function
in the connection configuration (NetPro).

Note

If you have assigned a new address to the Ethernet CP or have configured
connections, you must always download the connection configuration again.

Remember that you also make suitable address adaptations for the other stations
or “substitute objects”.

Relocating the CP in the Hardware Configuration

If you are using communication services with configured connections, the
connection IDs also identify the slot of the CP. If you “drag” a CP you have already
configured to a different slot, note the following:

Note

If you drag the CP to a different slot, the data of the connection configuration are
automatically updated. The data of the connection configuration must, however, be
downloaded again!

4
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Program

This chapter explains the following:

e How to send and receive data.

¢ Which data areas can be used on the S7 CPU.

e How to program the SEND/RECEIVE interface in the user program.

n You will find further information in the following sources:

e For programming and configuring nodes for connections (for example a
SIMATIC S5 PLC with the CP 1430 TCP, PC with CP 1413), please refer to t
appropriate manuals.

e The FCs for programming connections are described in Section 5.3.
e Configuring the Ethernet CP with NCM S7 is described in Chapter 4.
Sample programs:

Sample configurations and programs are available for the SEND/RECEIVE
interface described here:

¢ In the sample project PROJECT_ETHERNET that you can start immediately
after installing NCM S7; for a description, refer to the Primer /2/.

¢ On the Internet as downloadable sample projects; refer to the information in
Appendix C “Support and Training”.

The Quick Start CD that can be ordered separately is a
treasure-trove of sample programs and configurations.

You can order this directly on the Internet at:
http://www.ad.siemens.de/net/html_00/online_zugreifen.htm

SIMATIC NET NCM S7 for Industrial Ethernet
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3.1

How the SEND/RECEIVE Interface Works on the CPU

Functions (FCs)

Figure 3-1

The following functions (FCs) are available for handling communication on
connections:

e AG_SEND/AG_LSEND
This block takes the user data from the specified user data area and transfers it
to the Ethernet CP.

e AG_RECV/AG_LRECV
This block transfers received user data to the user data area specified in the
call.

The diagram below illustrates the situation. Using the FCs AG_SEND/AG_LSEND
and AG_RECV/AG_LRECV, the user program instructs the Ethernet CP to send or
receive data on the configured connection.

Ethernet station SIMATIC S7 — -
CPU ) Ethernet CP
‘| CP
STEP 7 ' database
user program '
! User data
User data areas ! buffer

AG_SEND

—3 send Communication

connection

receive

Interaction of the CPU and Ethernet CP on Connections

Amounts of Data

3-2

The Ethernet CP can transfer the amounts of data shown in the table below per job
on one connection:

Table 3-1
ISO Transport ISO-on-TCP TCP UDP
Sending 8192 bytes 8192 bytes 8192 bytes 2048 bytes
Receiving 8192 bytes 8192 bytes 8192 bytes 2048 bytes
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Note

The transfer of more than 240 bytes of data is supported by newer version CPs.
Please refer to the technical data in the product information of the Ethernet CP.
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3.2 Programming the SEND/RECEIVE Interface

Principle of Job and Data Transfer

The user program triggers the transfer of the user data areas with FC calls and
monitors the transfer by evaluating the return codes of the FCs.

The following parameters are transferred when the FCs are called:
¢ The number of the connection (ID)
e The location of the user data area in the CPU

For detailed information about the call interface see Chapter 5.

Purpose of the FCs
Calling the function blocks has the following effects:

* The user data area is transferred to the Ethernet CP or received from the
Ethernet CP.

¢ The execution of the job is confirmed positively or negatively in a status
message.

Programming Connections
Program the SEND/RECEIVE interface in the user program as follows:
1. Use the following functions (FCs) for data transmission on connections:
— AG_SEND for transferring the user data area to the Ethernet CP

— AG_RECYV for entering data received from the Ethernet CP in the user data
area

2. Evaluate the following bits in the FCs:
— for AG_SEND the parameters DONE, ERROR, STATUS
— for AG_RECYV the parameters NDR, ERROR, STATUS

Note

Connection numbers (IDs) must be taken from the configuration when
programming.

SIMATIC NET NCM S7 for Industrial Ethernet
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Calling FCs in the CPU Program
One possible sequence for FCs in conjunction with the organization and program

blocks in the CPU cycle is illustrated in the following diagram.

Read in the received

Read PII
data of the
* User broaram connection
4 OB I | | prog

AG_RECV

i

Communication

|:l>connection
AG. RECV
Communication
connection
AG_SEND -
AG_RECV ::\:l
Communication
connection
AG/SEND \\

Transfer send data
* for the connection

*'I_T AG.SEND

Write PIQ

>

Legend: w=pp-mm Sequence of the CPU cycle

CI——1—1 The different shading shows which
connections and FC blocks belong

together.

Figure 3-2  Typical Sequence of Function Calls in the CPU Cycle

The following points are illustrated by the diagram:

The user program consisting of any number of blocks (OBs, FBs or FCs —> see
/5/ accesses several connections (Figure 3-2 illustrates three connections).
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e At various points (event and program-controlled) the user program sends data
on a connection using the AG_SEND call.

e At various points in the CPU cycle, the user program accepts the data received
on the connection using an AG_RECYV call.

Note

The blocks can also be called more than once in a cycle for the same
communication connection.

SIMATIC NET NCM S7 for Industrial Ethernet
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3.3 Data Exchange S7 CPU <—> Ethernet CP

The Ethernet CP processes the send and receive jobs independent of the CPU
cycle and requires one transmission time. The interface to the user program with
the FCs is synchronized by an acknowledgment. Two situations must be
distinguished:

¢ The CPU cycle is faster than the transmission time.

e The CPU cycle is slower than the transmission time.

Note

Please refer to the sequence charts for the FCs in Chapter 5. These charts show
how to handle the SEND/RECEIVE interface in the user program for problem-free
data exchange.

Remember the points below about the CPU cycle and transmission time.

FC Calls Faster than the Transmission Time

If a block is called again in the user program before data were transferred or
received, the procedure is as follows on the interface of the FCs:

e AG_SEND/AG_LSEND:
No further job is accepted until the transmission of the data on the connection
has been acknowledged by the Ethernet station. During this time, the user
program receives the message “job active” until the Ethernet CP can accept the
next job on the same connection.

e AG_RECV/AG_LRECV:
The job is acknowledged with the message “no data available yet” if there are
no received data on the Ethernet CP. The user program receives this message
in the CPU cycle until the Ethernet CP has received data again on the
connection.

FC Calls Slower than the Transmission Time

If a block is called again before the data were completely transferred or received,
the procedure is as follows on the interface of the FC blocks:

* AG_SEND/AG_LSEND:
The job is positively acknowledged. The Ethernet CP is ready to receive
a new send job (at the earliest however with the next call).

e AG_RECV/AG_LRECV:
The job is acknowledged with “New Data Received” when the data have been
transferred to the user program. Following this, the FC call can be repeated.

SIMATIC NET NCM S7 for Industrial Ethernet
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Note

Remember that resource shortages can occur if the processing speeds on the
sender and receiver are not the same (sender faster than receiver).

The sender receives a message from the FCs if problems occur (“No resources on
the destination station”).

SIMATIC NET NCM S7 for Industrial Ethernet
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34 Additional Information

3.4.1 Programming Data Transfer on TCP Connections

Purpose of TCP Connections

TCP connections should be used above all for connections to systems of a
different type if they do not support RFC1006.

For communication between devices of the SIMATIC family, you should use the
more convenient ISO-on-TCP connections! The following sections explain certain
special points to note.

Special Features
e Block types (FC calls)

For data transfer, use only FC AG_LSEND (FC 50) and FC AG_LRECV (FC
60).

e Frame length

On the TCP connections, the protocol contains no information about the end of
a message and start of a new message.

The receiving station must therefore know how many bytes belong to a
message and transfer an ANY pointer corresponding exactly to this length when
FC AG_LRECV is called. (Example: if 100 bytes of data are always transferred,
the ANY pointer could appear as: P#DB100.DBX 0.0 Byte 100)

If you want to receive data with a variable length, follow the steps below:

Include information on the length of the user data in the frame before the actual
user data. In the receiving station, you evaluate only the length information and
then fetch the appropriate amount of data in a further receive job.

SIMATIC NET NCM S7 for Industrial Ethernet
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3.4.2 Recommendations for Use with a High Communications Load

Overview

The points below will help you to avoid overload situations on your CPU when
using the Ethernet CPs.

In particular when you replace an older CP with a newer CP and are then
confronted with overload problems, you should check your application for the
pitfalls outlined below.

Known Problems

¢ The functions for sending and receiving (FC 5/FC6 or FC 50/60) are often
called cyclically in OB1. This leads to constant communication between the
CPU and CP. As a result, other types of communication such as PG functions
cannot be executed or only very slowly.

e HMI systems access data of the CPU too often using S7 functions. This slows
down communication generally and there may be a lack of resources when
SEND/RECEIVE FCs are called cyclically in OB1.

Remedy
The recommendations below will help to avoid these situations:
¢ Do not call communication blocks cyclically in OB1!

Communication should be called time-controlled in a suitable cyclic-interrupt
OB. The call interval of this OB should be significantly higher than the average
cycle time of your program.

¢ You should set a minimum cycle time that is higher than the average runtime of
OBL1. This frees resources for communication on the CPU. This is, for example,
a remedy for existing applications when communication already takes place
cyclically in OB1.

¢ If necessary, reduce the time taken for communication processing on the CPU
by changing the parameters set for “cyclic load due to communication” in the
properties dialog of the CPU.

SIMATIC NET NCM S7 for Industrial Ethernet
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This chapter explains the following:

The general aspects of configuring communication connections
How to configure ISO transport connections, ISO-on-TCP and TCP connections

How to use the connection configuration functions to specify communication
partners that exchange data via UDP

You will find a description of the connection-specific properties dialogs in the
following sections:

v

ISO transport connections see Section 4.4
ISO-on-TCP connections see Section 4.5
TCP connections see Section 4.6

UDP see Section 4.7

You will find further information in the following sources:

For the properties of the configurable connection types, refer to Section 1.5.
For the properties of the configurable connection type E-mail, refer to /4/.

You will find information on the numbers of connections and amounts of data in
Section 3.1.

For information on configuring connections, refer to the online help of STEP 7
by selecting Help » Contents.
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4.1 Procedure

Steps
The following steps are necessary to operate connections on the SIMATIC S7 PLC
with the Ethernet CP:
Configuring Programming
r————————— !
Create new | If necessary, | Program the
connections | configure “Other | SEND/RECEIVE interface in
| Station” for | the user program.
| connections using the | .
| appropriate tool. | (Refer to Section 3.2 and the
| | detailed FC description in
| | Chapter 5).
Y S -
- Bl
| Configure connection |
| properties. |
L -1
Y Y

Download connection configurations
to the CP

necessary steps

optional steps

Figure 4-1  Operating Connections with the Ethernet CP
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4.2 Possible Connection Configurations

Connections within a Project

Connections are possible between different communication partners within a

project as shown in the following diagram.

Connections to communication partners outside a project are configured using
substitute objects such as “Other Stations” or SIMATIC S5.

Ethernet /IT-CP
CEthernetCP>  S7— 400

Ethernet CP.
S7-400 @ S7-1300

ya

PG/PC with Ethernet CP

Subnet 2

Ethernet CP

|/

| 1|
J—] [

I

] o o T o

|

I 1

SIMATIC S5

Figure 4-2  Possible Connections
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4.3 Connections

Characteristics of a Connection

A communication connection allows program-controlled communication between
two nodes on Industrial Ethernet with the following characteristics:

e The data transfer is bi-directional, in other words, it is possible to transmit and
receive on the connection simultaneously.

¢ Both stations have the same rights, in other words, each station can trigger the
send and receive procedures in response to events.

e The address of the communication partner is specified in the configuration.

The free UDP connection is the exception to this. Here, the address is specified
at the FC interface in the user program.

SIMATIC S7 station
with Ethernet CP

send

receive

send

receive

Ethernet
node
L receive
Communication
connection
send
Ethernet
node
receive
Communication
onnection
send

Figure 4-3  Sending and Receiving via one Communication Connection

Note

The term “connection” is also used here for UDP. Reason: during configuration
(just as in TCP) the communication partners are assigned to each other and
therefore logically “connected”. In actual fact, with UDP there is no explicit
connection establishment between communication partners.

4-4
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Amounts of Data

Refer to the product information /1/ accompanying the Ethernet CP for the number
of communication connections supported by the Ethernet CP. The number of
connections per station can be increased by adding more CPs.

The Ethernet CP can transfer the amounts of data shown in the table below per job
on one connection:

Table 4-1
ISO Transport ISO-on-TCP TCP UDP
Sending 8192 bytes 8192 bytes 8192 bytes 2048 bytes
Receiving 8192 bytes 8192 bytes 8192 bytes 2048 bytes
Note

The transfer of more than 240 bytes of data is supported by newer version CPs.
Please refer to the technical data in the product information of the Ethernet CP.

Tasks of the Ethernet CP

When handling the data transfer on a connection, the Ethernet CP has the
following tasks:

¢ When receiving

Receiving data from Ethernet and transferring it to the user data area on the
CPU.

¢ When sending

Taking data from the user data area on the CPU and sending the data via
Ethernet.

For a free UDP connection, the following functions are also necessary in addition
to those above:

¢ When receiving
Entry of the sender of the message in the job header.
¢ When sending
Evaluation of the job header and addressing the partner

The connection is established automatically as soon as the partner is obtainable.

SIMATIC NET NCM S7 for Industrial Ethernet
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Requirements for Configuring Connections

4-6

The Ethernet CP was entered in the hardware configuration and connected to the
subnet.

As a bus node, the Ethernet CP has an address.

Note

All stations not in the STEP 7 project must be configured with substitute objects
(for example as “SIMATIC S5” or “Other stations”).

or

Use the “unspecified” partner type when you create the connection.
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43.1

Principle

Creating a New Connection

When you create new connections, you start from entered and networked stations.
A connection is then configured starting from a station or CPU in the current S7
project and then selecting a destination station.

Due to the networking, the node addresses (MAC or IP addresses) of the two
stations are already decided. The local/remote TSAPs (Transport Service Access
Point) or ports at both ends of the connection are automatically assigned default
values.

If the partner station is a station outside the current project or a non-S7 station, the
remote TSAPs (Transport Service Access Point) or ports must be specified in the
Properties dialog of the connection.

The endpoint of the connection to a SIMATIC S7 station is always a CPU. A
separate connection table is created for each CPU and displays the connection
partner and types of connections.

How to Open the Connection Table

You can open the connection table in a variety of ways:

Using the “Start” button in the Windows taskbar SIMATIC » STEP 7> Configure
Networks, you open the NetPro graphic representation.

In NetPro, follow the steps below:

1. In NetPro, select the station or the CPU in the station from which you want to
establish the connection.

2. Select the menu command Insert » New Connections (also available with the
right mouse key!).

As an alternative, you can start in the SIMATIC Manager, as follows:

1. Open your CPU in the SIMATIC Manager.
2. Select the object Connections ﬁ' .

3. Double-click the object or select the menu command
Edit » Open Object.

Result: The connection table appears on the screen with all the connections
configured for the selected CPU (local node).

As an alternative, you can also open the connection configuration from the graphic
network view. Select the station or CPU of the station in NetPro. Select the Insert
» New Connections menu command.

SIMATIC NET NCM S7 for Industrial Ethernet
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New Connection

To configure a new connection, the stations and their CPs must be configured and
networked in the S7 project. To create a new connection, follow the steps below:

1. Select the menu command Insert » New Connection

Result: The following dialog appears on the screen.

New Connection
— Connection Parner | -
Statian: ISIMATIC 400-5tation(2) S
Module: ICPU414—1 1
—Connection
Tiyme: IISO Transpart Connection j
_ oo Inech
T/ Canfig i |5 0-0r-TCP Cornnection
37 Point-To-Point Cannection

ok | Corcel | Hep |

Figure 4-4  Layout of the “New Connection” Dialog (Example of an ISO Transport Connection)

2. In the “Station” box, select the station to which you want to establish a
connection. After you have selected your local station, all the remote partners in
the S7 project and all their programmable modules (CPUSs) are displayed for
selection.

3. In the “Module” box, select the CPU in the station to which you want to
establish a connection .

4. Select the connection type you want to use (for example 1SO transport
connection) in the “Type” box

If you confirm your entries with Add, the new connection is created and the “New
Connection” remains open. This allows you to create further connections without
needing to reopen the dialog box. At the same time, the connection list is updated.

When you click OK, the connection is entered in the list, the dialog is terminated
and the display in the main dialog is updated.

If you click Cancel, the dialog is terminated and the connection is not entered in
the list.

SIMATIC NET NCM S7 for Industrial Ethernet
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Connections to Non-S7 Stations using Substitute Objects

4.3.2

If you want to configure connections to devices or stations that are not S7 stations,
select a station of the type “SIMATIC S5”, “PC/PG” or “Other Station” as the
destination station.

By creating these stations in NetPro and networking them, you have already
specified the node addresses (MAC or IP addresses) of the two stations. You must
specify the TSAP (Transport Service Access Point) for the destination station.

Note

Connections to non-S7 stations (for example SIMATIC S5) are generated as
incompletely specified connections; in other words, the remote TSAP or port is
empty. These connections must be specified in the Properties dialog.

Connections to Partners in Other Projects

There are two ways of creating connections to partners configured in other STEP 7
projects or with other tools outside the current STEP 7 project:

e Connections using substitute objects such as “SIMATIC S5”, “PC/PG” ,
“SIMATIC PC-Station” or “Other Station”.

This method is described in the section above.

¢ Unspecified connections

Unspecified Connections

Connections to an as yet unknown device (for example a diagnostic unit) are
configured as “unspecified” connections. They can be specified later in the
Properties dialog.

You can create an unspecified connection simply by selecting station “unspecified”
for the connection partner when you create the connection. The unspecified
connection can be used in two ways (explained below based on the example of an
ISO-on-TCP connection (ISO transport and TCP connections are analogous):

¢ Declare readiness for communication — passive connection establishment

The connection establishment is then set to passive (see settings in the
General tab).

The address setting for the ISO-on-TCP connection is then as follows:

The remote IP address is 0.0.0.0 and the remote TSAP is empty; in other
words, they are not relevant for the CP. When the connection is established,
any partner is accepted (partner = connection name that addresses the CP with
the correct IP address and TSAP).

It is also possible to use a partial specification; in other words, communication

SIMATIC NET NCM S7 for Industrial Ethernet
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is permitted with any partner that matches the specified TSAP.

e Connection to a specific station in any project

The address setting for the ISO-on-TCP connection is then as follows:
You can specify the remote IP address and the port of any destination station.
The destination station can be in the current STEP 7 project or in another

project.

Use this method if you have not created a substitute object for the partner

station, for example SIMATIC S5, in the current project.

The following table lists the possible options.

Table 4-2
Meaning for Connection IP Address / TSAP / Port Possible Connection
Establishment MAC Address Establishment
by any partner empty empty passive
by any partner via specific TSAP empty specified passive
to or by a specific partner specified specified active / passive

4-10

The free UDP connection is another variant. With this type of connection, the
address of the connection partner is left open during configuration. The
communication nodes are identified by address information in the communication

job in the user program.

For further information, refer to the sections dealing with specific connections.

Note

The number of connections possible per Ethernet CP can be found in the product
information /1/supplied with the CP. If several CPs are installed in one station, the
next CP is automatically selected if the limit is exceeded. The connections can be
routed in the Properties dialog of the connection.

SIMATIC NET NCM S7 for Industrial Ethernet
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4.3.3 Further Functions
Toolbar
In the toolbar of the connection configuration dialog the following functions are
available:
Save To save the configured connection, select the Save function or click the save

button.

=

Print You can print the entire connection table or individual sections of it by selecting
the Print function or clicking the print button.

@ The following print options are available:
* Overview of all connections (complete connection table)
* Overview of the selected connections (selected area)
* Detailed printout of all connections (details of all connections)
* Detailed printout of the selected connections (details of the selected area)

Change Connection You assign a new partner station to the selected connection.
Partners Important!
@f Remember that this also changes the partner ID on connections of the

SEND/RECEIVE interface. You may need to adapt your user program.

Insert Connection You create a new entry in the connection table.

AN

Download You download the connection table to the PLC. For more detailed information
call up the integrated help function.

Lo

Help If you require help or more information, select the Help function or click the
help button.

The help button provides you with context-related help. Using the help function
you call a help dialog familiar from other Windows applications.

-
~J

Print Function in the “Overview” Tab

An additional function for printing the configured connections and configuration
status is available in the “Overview” tab.

SIMATIC NET NCM S7 for Industrial Ethernet
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4.3.4

Overview

Connections Without Assignment

This section explains the actions that can lead to a configured connection losing its
assignment to the CP or being deleted.

Note

Remember that in contrast to the S7 connections, the connections of the
SEND/RECEIVE interface are assigned a CP-dependent ID. The actions below
may require the ID to be modified so that the interface information in the user
program must also be adapted.

Table 4-3  Actions That Can Cause Changes to Configured Connections

Action

Consequences for the
Connections

How to Establish the Connection
Again

The CP (module) is
moved to a different
location in the hardware
configuration (drag and
drop)

The connections are retained.

The connection IDs are
automatically updated.

1. Adapt the module start address
LADDR in the user program.

2. Download the connection
configuration to the CP again.

The CP (module) is
deleted in the hardware
configuration.

You receive the message
“CP has n connections;
the assignment will be lost
in the connection table”.

The connections remain without
assignment to a CP in the
connection table. In the
“Overview” tab of the Properties
dialog, the connections are
identified with “I”.

Once you have placed a CP in the
hardware configuration and networked it:

1. Assign the CP in the connection
properties dialog in the “Addresses”
tab.
or
Reassign the connection using the
menu option Edit » Connection
Partner....

2. Adapt the connection ID in the user
program.

3. Download the connection
configuration to the CP again.

Deleting the SIMATIC S7
station.

All the connections to this station
are deleted within the project.

Reconfigure the station and
connections.

4-12
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Table 4-3  Actions That Can Cause Changes to Configured

Connections, continued

Action Consequences for the
Connections

How to Establish the Connection
Again

Deleting a remote station. | The connections of the stations
in the project to remote stations
remain without assignment in
the connection table. In the
“Overview” tab of the Properties
dialog, the connections are

Reassign a remote station (or even a
local station) using the menu option Edit
» Connection Partner....

without an assignment in the
connection table. In the
“Overview” tab of the Properties
dialog, the connections are
identified with “!”.

identified with “I”.
Changing the subnet The connections that were Reassign the connections using the
assignment of the CP. assigned via the CP remain menu option Edit » Connection

Partner... or in the “Addresses” tab of
the properties dialog for the connection.

Display (Example)

The status of connections is displayed in the “Properties ISO Transport

Connection” dialog in the “Overview” tab.

Propertiez - 150 Transport Connection

General | Addreszes
Optians Ouerviem
Connections:

I Dynamics
Statuz |nformation

Local I | Connh. name | R4S | R emote addressl Local TS.-'l'-.F'l R emot

<] |

™ Display connections of all CPUs

Frint Configuration | Prrirt |

0007 A020  150-4erbi.. 044 08.00.06.01.00.01 15041
0002 4020 150-erbi.. 044 08.00.06.01.00.01 150-2
0002 4021 150-4erbi.. 047 150-2
0003 A020  150-erbi.. 044 08.00.06.01.00.02 15041
0004 A020  150-4erbi.. 044 08.00.06.01.00.03 15041
00054020 150-4erbi.. 044 08.00.06.01.00.03 150-2

i

Cancel | Help |

Figure 4-5  Status of the Connections in the “Overview” Tab

SIMATIC NET NCM S7 for Industrial Ethernet
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Note

If a CP is replaced by a different CP, this must provide at least the same services
and must be at least the same version.

SIMATIC NET NCM S7 for Industrial Ethernet
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4.4 Configuring ISO Transport Connections

Introduction

As well as the entry in the connection table, you can also modify special properties
for each configured connection.

Here, you can change specific connection parameters that were entered as
defaults during the new connection dialog.

Calling the Dialog

To call the dialog for special connection properties, follow the steps outlined below:

1. Select the required connection in the connection table.

2. Select the menu option Edit » Object Properties

Result: The “Properties ISO Transport Connection” dialog appears.

Tabs

The following tabs are available for ISO transport connections:

General
Displays the global parameters of the connection and the local name of the ISO
transport connection.

Addresses
Displays the local and remote address information.

Dynamics
Displays the relevant timers and counters.

Options
Here, you can select the following modes:

— FETCH or WRITE

Overview
This is an overview of all the configured ISO transport connections of the
selected S7 station with their parameters and the status of the connection.

Status Information

This tab displays the current status information for the connection (valid at the
time the dialog is opened). This information corresponds to that displayed by
NCM diagnostics.

SIMATIC NET NCM S7 for Industrial Ethernet
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44.1

General Tab

Specifying ISO Transport Connection Properties

This tab in the properties dialog displays parameters for the connection and the
local connection name of the ISO transport connection.

The local ID is identical to the ID in the NetPro connection table (STEP 7
connection configuration) and is shown here to illustrate the assignment.

Propertiez - 150 Transport Connection

Optiohz |
General |

Ouerview
Addreszes

— Connection Endpaint

Local 1D [hex):

0071 AQ20

Hame: IISD-"»-"erI:uindung-‘I

wia CF: |EF' 4431 150 - [RO/S4)

Route... |

W Active connection establishment

Statuz |nformation

I Dynamics

— Block Parameters

1—ID

Wi #0200 —LADDR

Cancel Help

Figure 4-6
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Layout of the Properties Dialog for the “General” Tab (ISO Transport Connections)
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the FC in the user program to identify the connection.

Attributes Description Access
Connection
Endpoint
Local ID Identical to the value from the connection list Selectable
Name Proposed name that can be changed by the user. With unspecified Modifiable
connections, use this box to identify the partner.
Via CP If the station contains more than one CP of the same type connected | Display only
to the same subnet, you can select the connection route. —> “Route”
button see Section 4.8.
If no CP is assigned (for example because the CP was previously
deleted) “none” is displayed here.
Active Connection | The default setting is active. If the connection is unspecified, Modifiable
Establishment establishment is passive.
ON: the connection is established actively.
OFF: the connection is established by the partner.
Block Parameters
ID This value must be entered as a block call parameter ID for calling Display only
the FC in the user program to identify the connection. The ID
changes if the local ID is changed.
LADDR This value must be entered as a block call parameter ID for calling Display only

“Active Connection Establishment” Option

With this option, you specify whether the connection is established by this S7
station. This is the default setting when the address of the partner is specified.

If you selected partner “unspecified” when you created the connection, the option
is deselected as default. If you activate the option, you must also specify the
address of the partner in the “Addresses” tab.

If you select FETCH or WRITE in the “Options” tab, the option is deselected
(passive connection establishment) and cannot be selected.

SIMATIC NET NCM S7 for Industrial Ethernet
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4.4.2 Specifying ISO Transport Addresses

Address Parameters

An ISO transport connection is specified by the local and remote connection
endpoint.

¢ Local addresses:
Local MAC address and local TSAP
(Transport Service Access Point)

¢ Remote addresses:
Remote MAC address and remote TSAP

— Ethernet station A ( Ethernet station B

Remote . * Local
ISO transpor
connection
Local Remote
GO G

MAC MAC
address A address B

Figure 4-7  Sending and Receiving on one ISO Transport Connection

Note

The TSAPs of an ISO transport connection must match as follows:
Remote TSAP (on Ethernet CP) = local TSAP (in destination station);
Local TSAP (on Ethernet CP) = remote TSAP (in destination station);

SIMATIC NET NCM S7 for Industrial Ethernet
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Addresses Tab

The addresses tab displays proposed values for the relevant local and remote
address information. When connecting to non-S7 stations, you can set the TSAP
addresses individually.

Propertiez - 150 Transport Connection |
Optiots I Deverview | Statuz Infarmation
General Addresses | Diynamics
Local Remote
MaAC [HEX]: 08.00.06.07.00.00 |EIE!.EIEI.EIE.EI1.EIEI.EI'I
TSaP [AsCH): |ISEI-1
TSAP HEX):  |49.53.4F.20.31 [49.53.4F 2D 31
TSAF length: ] ]

Cancel Help

Figure 4-8 Layout of the “Addresses” Tab of the Properties Dialog with Default TSAPs

TSAP Format

ISO transport connections have a TSAP length of 1 to 32 bytes. When you are
entering values, the current length is displayed automatically (visible display: 20
ASCII characters). Local and remote TSAPs can be input as hexadecimal values
or as ASCII strings. If you make your entries in ASCII, the characters you enter are
also displayed in hexadecimal format. If you make your entries in hexadecimal,
printable characters are displayed in ASCII (8 hexadecimal values are visible). If
you enter nonprintable characters, the ASCII display is gray (no further ASCII
entries possible) and the nonprintable characters are displayed as periods.

Local and Remote TSAPs

Remote and local TSAPs can be identical since the connection is uniquely
identified by the different MAC addresses. If you require more than one connection
between two stations, the TSAPs must also be different.

SIMATIC NET NCM S7 for Industrial Ethernet
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Default TSAPs

When configuring the local and remote TSAPSs, there is a default value “ISO-1" for
the first connection between the two partners (can be changed). For a new
connection between the two partners, the default value “ISO-2" is proposed. With a
new connection to a new partner, the value ISO-1 is used again.

Addresses Tab — Unspecified ISO Transport Connection

Figure 4-9

4-20

If you select the partner type as “unspecified”, depending on your task, you can
enter address information about the communication partner here. The options
available to you are explained in detail in Section 4.3.1.

The Addresses tab shown here illustrates the situation in which the MAC address
and the remote TSAP were not specified. If you do not make any further settings,
this means that you are willing to accept a connection establishment request from
any communication partner.

Propertiez - 150 Transport Connection |
Optiots I Deverview | Statuz Infarmation
General Addresses | Diynamics
Local Remote
MALC [HE=): 08.00.06.07.00.00 |
TSAP 4SO [IS0-2 |
TSAPHEX):  [49.53.4F.20.32 |
TSAF length: ] ]

Cancel Help

Layout of the “Addresses” Tab of the Properties Dialog for an Unspecified Connection
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4.4.3 Specifying ISO Transport Dynamic Properties

Dynamics Tab

The Dynamics tab displays the relevant timers and counters of this connection.
You can normally accept these default values.

If necessary, for example with connections to non-Simatic systems, you can set
the timers and counters individually and influence the dynamic response of the

connection.
Propertiez - 150 Transport Connection |
Optiohz I Ouerview I Status |nformation |
General I Addreszes Dynamics

The fallowing walues should only be changed in zpecial cazes!

— Connection E stablizhment

Retranzmizzion time [z];

— Data Tranzfer

RBetranzmizzion time [100 mz]; I'IEI bax. count: |5
Inactivity time [=]: ISEI

Wfindow time [2]: 10

Cancel Help

Figure 4-10 Layout of the “Dynamics” Tab of the Properties Dialog

Attributes Description Access

Connection Establishment

Retransmission Time The retransmission time specifies the interval after
which an unsuccessful connection establishment

attempt can be triggered again (1-60 s, default 5 s)
— if connection establishment is active Modifiable
— if connection establishment is passive (—> irrelevant)

Data Transfer

Retransmission time This parameter specifies the interval after which an Modifiable
unsuccessful transmission attempt can be triggered
again (100—-30000 ms, default 1000 ms).

Max. Count Max. Count is the number of attempted Modifiable
transmissions including the first (1-100, default
5).

SIMATIC NET NCM S7 for Industrial Ethernet
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Attributes Description Access
Inactivity Time The inactivity time specifies the interval after Modifiable
which the connection is terminated if no sign of
life is received from the partner (6-180 s,
default 30 s).
Window Time The window time specifies the interval at which Display only

sign of life frames are sent. For SIMATIC NET
CPs, the window time is set to 1/3 of the
inactivity time (2—60 s, default 10 s). Sign of life
frames are sent to check the connection when
there is no data traffic.

Note

Window Time and Inactivity Time
The partner responds to a sign of life frame with a frame. They are therefore sent
to the partner at the intervals of the window time. To avoid unwanted connection
termination, the inactivity time should be at least three times as long as the

window time.

4-22
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4.4.4 ISO Transport with the FETCH/WRITE Mode

Using FETCH PASSIVE / WRITE PASSIVE

If you select one of the FETCH PASSIVE or WRITE PASSIVE modes for the 1ISO
transport connection, you can access the system areas on a SIMATIC S7 PLC
from a SIMATIC S5 station or other non-S7 station.

Propertiez - 150 Transport Connection E3
General I Addresses I Dynamics
Optiohz | Overviem I Statuz |nformation
Local
Operating mode:  [retch passive j
Send.-"FEeu:

:Fetch paszive
Wirike pazsive

Cancel Help

Figure 4-11

The connection can then only be used for this mode; sending or receiving with the
FCs AG_SEND/AG_LSEND or AG_RECV/AG_LRECYV is then no longer possible.

The connection establishment is passive; in other words, only the partner station
(SIMATIC S5 station or other non-S7 station) can establish the connection. The
setting is made automatically in the “General” tab and cannot be changed.

« FETCH

If you select the FETCH mode, you allow direct read access to system memory
on the SIMATIC S7 PLC. Such access can be, for example, from a SIMATIC
S5 station or other station.

* WRITE

If you select the WRITE mode, you allow direct write access to system memory
on the SIMATIC S7 PLC. Such access can be, for example, from a SIMATIC
S5 station or other station.

SIMATIC NET NCM S7 for Industrial Ethernet
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Note

If you select this configuration for an S7-300, remember that a connection
resource (free connection for S7 Functions) of the S7-300 CPU is used! CPU
connection resources are also used, for example, by S7-300 CPs, in the FMS
mode or by PGs and OPs. For more detailed information about the maximum
connection resources, refer to /12/ and /6/.

System Memory

You can access the following address areas in the system memory on the
SIMATIC S7 PLC using FETCH or WRITE:

e Data blocks (DB)
(When accessing DBs, remember that the highest DB number is 255.)
e Bit memory (M, MB, MW, MD)
e Process image input table (I, 1B, IW, ID)
¢ Process image output table (Q, QB, QW, QD)
e |/O area inputs (PIW, PID, PIB)
¢ |/O area outputs (PQW, PQD, PQB)
e Counters (C)
e Timers (T)

Links to Other Systems

Messages

4-24

The FETCH and WRITE modes supported on ISO transport connections and
ISO-on-TCP or TCP connections can be used with any other device to access the
S7 system memory areas.

To be able to use this type of access, for example for PC applications, you need to
know the PDU structure of the jobs. The required S7 or S5 headers for request
and response frames are 16 bytes long and their structure is described in the
Appendix.

in the Diagnostic Buffer

As a result of FETCH/WRITE access, negative acknowledgments from the S7
CPU are possible. This then leads to corresponding connection-oriented entries in
the diagnostic buffer that you can read out with NCM Diagnostics (see Section
6.5).
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4.4.5 Checking ISO Transport Connection Properties

Overview Tab

The Overview tab displays all previously configured ISO transport connections and
their parameters for this station (information only).

Propertiez - 150 Transport Connection |
General | Addresses I Dynamics
Optiohs Overview | Statusz Infarmnation
Connections:
Local I | Connh. name | R4S | R emote addressl Local TS.-'l'-.F'l R emot
0001 4020 1504erbi... 044 08.00.08.01.00.01 1501
0002 4020 1504erbi... 044 08.00.08.01.00.01 150-2
0002 4021 1504erbi... 047 150-2
00034020 1504erbi... 044 08.00.08.01.00.02 1501
0004 4020 1504erbi... 044 08.00.08.01.00.03 1501
0005 4020  1504erbi... 044 08.00.08.01.00.03 150-2
4| | i
™ Display connections of all CPUs
Frint Configuration | Prrirt |
Cancel | Help |

Figure 4-12  Layout of the “Overview” Tab of the Properties Dialog

Parameter Description
Local ID This is the connection ID of the ISO transport connection
Conn. Name Entered connection hame identifying the 1ISO transport connection.
R/S Rack/slot of the local CP via which the connection is established.
Remote Specifies the remote MAC address of the connection on the Ethernet
address subnet.
Local TSAP Local transport service access point.
Partner TSAP Remote transport service access point.
Status The status displays the current configuration status of the connection.

“Connections without assignment” are indicated by “No local CP/No remote
CP” in the status column and a “!I” character at the end of the“Local ID” (for
example: 0002 A00O!).

Connections you are currently editing are also indicated by “!” at the end of
the local ID.

You can set the column widths in the “Overview” tab individually.
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Connection Overview with Multiple CPUs in an S7 Station

If you operate more than one CPU in your S7 station, you can click the button to
extend the overview to the connections on all CPUs.

SIMATIC NET NCM S7 for Industrial Ethernet
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4.5 Configuring ISO-on-TCP Connections Properties

Introduction

As well as the entry the connection table, you can also modify specific connection
parameters that were entered as defaults during the New connection dialog.

Calling the Dialog

To call the dialog for special connection properties, follow the steps outlined below:

1. Select the required connection in the connection table.

2. Select the menu option Edit » Object Properties

Result: The “Properties ISO-on-TCP Connection” dialog appears.

Tabs

The following tabs are available for ISO-on-TCP connections:

General
Displays the parameters of the connection and the local name of the
ISO-on-TCP connection.

Addresses
Displays the local and remote address information.

Options
Here, you can select the following modes:

— FETCH or WRITE

Overview
This is an overview of all the configured ISO-on-TCP connections of the
selected S7 station with their parameters and the status of the connection.

Status Information

This tab displays the current status information for the connection (valid at the
time the dialog is opened). This information corresponds to that displayed by
NCM diagnostics.
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45.1 Specifying the ISO-on-TCP Connection Partner

General Tab

This tab in the properties dialog displays global parameters for the connection and
the local connection name of the ISO-on-TCP connection.

The local ID is identical to the ID in the NetPro connection table (STEP 7
connection configuration) and is shown here to illustrate the assignment.

Propertiez - 150-on-TCP Connection |
General | Addresses I I:Iptic.nsl Dwerview I Status |nformation I
— Connection Endpaint — Block Parameters

Local 1D [hex):

a—ID

Neme:  [I50-on TERVarb 3 WiH1GH1FFC —{LADDR

Yia CP: ||:F- 443-1 - [RO/57]

Route... |

W Active connection establishment

Cancel Help

Figure 4-13 Layout of the “General” Tab in the Properties Dialog for ISO-on-TCP Connections
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Parameter Description Access
Connection Endpoint
Local ID Identical to the value from the connection list Selectable
Name Proposed name plus suffix connection number that can be Modifiable
changed by the user (max. 24 characters).
Via CP If the station contains more than one CP of the same type Display only
connected to the same subnet, you can select the connection
route. —> “Route” button see Section 4.8.
If no CP is assigned (for example because the CP has been
deleted) “none” is displayed here.
Active Connection With this option, you specify whether the connection is Modifiable
Establishment established by this S7 station. This is the default setting when
the address of the partner is specified.
If you selected partner “unspecified” when you created the
connection, the option is deselected as default. If you activate
the option, you must also specify the address of the partner in
the “Addresses” tab.
If you select FETCH or WRITE in the “Options” tab, the option is
deselected (passive connection establishment) and cannot be
selected.
ON: the connection is established actively.
OFF: the connection is established by the partner.
Block Parameters
ID This value must be entered as a block call parameter ID for Display only
calling the FC in the user program to identify the connection.
The ID changes if the local ID is changed.
LADDR This value must be entered as a block call parameter ID for Display only

calling the FC in the user program to identify the connection.
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45.2 Specifying 1SO-on-TCP Addresses

Address Parameters
A connection is specified by the local and remote connection endpoint.

¢ Local addresses:
Local IP address and local TSAP
(Transport Service Access Point)

Remote addresses:
Remote IP address and remote TSAP

— Ethernet station A ( Ethernet station B —

Remote Local
TSAP * 1SO-on-TCP

Local connection Remote
:l\:l . ISAP

IP IP
address A address B

Figure 4-14 Sending and Receiving on one ISO-on-TCP Connection

The address parameters are configured with NCM S7 and saved in the CP
database. Modifications and extensions to the Industrial Ethernet network topology
do not therefore have any effect on the CPU user program.

Note

When you configure the Ethernet CP and the Ethernet destination station, the
TSAPs of an ISO-on-TCP connection must cross match:

Remote TSAP (in Ethernet CP) = local TSAP (in destination station)

Local TSAP (in Ethernet CP) = remote TSAP (in destination station)

SIMATIC NET NCM S7 for Industrial Ethernet
4-30 C79000-G8976-C129/04



Configuring Communication Connections

Addresses Tab

Figure 4-15

The addresses tab displays proposed values for the relevant local and remote
address information. If necessary, you can set the TSAP addresses individually.

Propertiez - 150-on-TCP Connection |
General Addreszes | Dptiu:unsl Owerview I Statusz Information I
Local Fartrer
IP [dec]: 140.80.0.4 |1 40.80.0.3
T5AP(asCE (DA |TCP-2
TSAP [hex]: |54.43.5EI.2D.3‘I |54.43.5EI.2D.32
TSAF length: ] ]

Cancel Help

Layout of the “Addresses” Tab of the Properties Dialog with Default TSAPs for ISO-on-TCP
Connections

TSAP Format

Local and

ISO-on-TCP connections have a TSAP length of 1 — 32 bytes. When you are
entering values, the current length is displayed automatically (visible display: 20
ASCII characters). Local and remote TSAPs can be input as hexadecimal values
or as ASCII strings. If you make your entries in ASCII, the characters you enter are
also displayed in hexadecimal format. If you make your entries in hexadecimal,
printable characters are displayed in ASCII (8 hexadecimal values are visible). If
you enter nonprintable characters, the ASCII display is gray (no further ASCII
entries possible) and the nonprintable characters are displayed as periods.

Remote TSAPs

Remote and local TSAPs can be identical since the connection is uniquely
identified by the different MAC addresses. If you require more than one connection
between two stations, the TSAPs must also be different.

SIMATIC NET NCM S7 for Industrial Ethernet
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Default TSAPs

When configuring the local and remote TSAPSs, there is a default value “TCP-1" for
the first connection between the two partners (can be changed). For a new
connection between the two partners, the default value “TCP-2" is proposed. With
a new connection to a new partner, the value TCP-1 is used again.

Addresses Tab — Unspecified 1ISO-on-TCP Connection

If you select the partner type as “unspecified”, depending on your intentions, you
can enter address information about the communication partner here. The options
available to you are explained in detail in Section 4.3.1.

The Addresses tab shown here illustrates the situation in which the remote IP
address and the remote TSAP were not specified. If you make no further entries,
you are accepting connection establishment from any communication partner.

Propertiez - 150-on-TCP Connection |
General Addreszes | Dptiu:unsl Owerview I Statusz Information I
Local Fartrer
I [dec: 140.80.0.2 Il

ISAP ASCE  |TCPA |

TSAP [hex): |54.43.5EI.2I:|.31 |

TSAF length: ] ]

Cancel Help

Figure 4-16 Layout of the “Addresses” Tab of the Properties Dialog for an Unspecified Connection
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45.3 ISO-on-TCP with the FETCH/WRITE Mode

Using FETCH PASSIVE / WRITE PASSIVE

If you select one of the FETCH PASSIVE or WRITE PASSIVE modes for the
ISO-on-TCP connection, you can access the system areas on a SIMATIC S7 PLC
from a SIMATIC S5 station or other non-S7 station.

Propertiez - 150-on-TCP Connection E3
General I Addreszes | Options | Dverview I Statuz Information I
Local Remote
Operating mode: | cond/Recy j ISend.-"Hecv j

Send/Recy

Wirike pazsive

Cancel Help

Figure 4-17

The connection can then only be used for this mode; sending or receiving with the
FCs AG_SEND/AG_LSEND or AG_RECV/AG_LRECYV is then no longer possible.

The connection establishment is passive; in other words, only the partner station
(SIMATIC S5 station or other non-S7 station) can establish the connection. The
setting is made automatically in the “General” tab and cannot be changed.

« FETCH

If you select the FETCH mode, you allow direct read access to system memory
on the SIMATIC S7 PLC. Such access can be, for example, from a SIMATIC
S5 station or other station.

* WRITE

If you select the WRITE mode, you allow direct write access to system memory
on the SIMATIC S7 PLC. Such access can be, for example, from a SIMATIC
S5 station or other station.

SIMATIC NET NCM S7 for Industrial Ethernet
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Note

If you select this configuration for an S7-300, remember that a connection
resource (free connection for S7 Functions) of the S7-300 CPU is used! CPU
connection resources are also used, for example, by S7-300 CPs, in the FMS
mode or by PGs and OPs. For more detailed information about the maximum
connection resources, refer to /12/ and /6/.

System Memory

You can access the following address areas in the system memory on the
SIMATIC S7 PLC using FETCH or WRITE:

e Data blocks (DB)
(When accessing DBs, remember that the highest DB number is 255.)
e Bit memory (M, MB, MW, MD)
e Process image input table (I, 1B, IW, ID)
¢ Process image output table (Q, QB, QW, QD)
e |/O area inputs (PIW, PID, PIB)
¢ |/O area outputs (PQW, PQD, PQB)
e Counters (C)
e Timers (T)

Links to Other Systems

Messages

4-34

The FETCH and WRITE modes supported on ISO transport connections and
ISO-on-TCP or TCP connections can be used with any other device to access the
S7 system memory areas.

To be able to use this type of access, for example for PC applications, you need to
know the PDU structure of the jobs. The required S7 or S5 headers for request
and response frames are 16 bytes long and their structure is described in the
Appendix.

in the Diagnostic Buffer

As a result of FETCH/WRITE access, negative acknowledgments from the S7
CPU are possible. This then leads to corresponding connection-oriented entries in
the diagnostic buffer that you can read out with NCM Diagnostics (see Section
6.5).
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45.4 Checking 1ISO-on-TCP Connection Properties

Overview Tab

The overview shows all the configured 1ISO-on-TCP connections and their
parameters (cannot be modified here).
You can adjust the width of the columns in the table.

Propertiez - 150-on-TCP Connection |
General | Addresses | Options  Overview | Status Information |
Connections:
Local I | Connh. name | R4S | R emote addressl Local TS.-'l'-.F'l F
o003 A021  150-on-T... 047 140.80.0.3 TCPA
o009 A0211  150-on-T... 047 140.80.01 TCPA
o009 4080 150-on-T... nsa 140.80.0.3 TCPA

.| | i

™ Display connections of all CPUs

Frint Configuration | Prrirt |

Cancel | Help |

Figure 4-18 Layout of the “Overview” Tab in the Properties Dialog for ISO-on-TCP Connections

Parameter Description
Local ID This is the connection ID of the ISO-on-TCP connection
Conn. Name Entered connection name This identifies the ISO-on-TCP connection.
R/S Rack/slot of the local CP via which the connection is established.
Remote Specifies the remote IP address of the connection.
Address
Local TSAP Local transport service access point.
Remote TSAP  Remote transport service access point (8 characters default width).
Status The status displays the current configuration status of the connection.

“Connections without assignment” are indicated by “No local CP/No remote CP” in the
status column and a “!” character at the end of the“Local ID” (for example: 0002 A0QO0!).
Connections you are currently editing are also indicated by “!I" at the end of the local ID.

Connection Overview with Multiple CPUs in an S7 Station

If you operate more than one CPU in your S7 station, you can click the button to
extend the overview to the connections on all CPUs.
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4.6 Configuring TCP Connection Properties

Introduction

After the entry in the connection table, you can modify specific connection
parameters for each configured connection that were given default values when
you created the connection.

Calling the Dialog
To call the dialog for special connection properties, follow the steps outlined below:
1. Select the required connection in the connection table.
2. Select the menu option Edit » Object Properties

Result: The “Properties — TCP Connection” dialog appears.

Tabs
The following tabs are available for TCP connections:

e General
Displays the parameters of the connection and the local name of the TCP
connection.

e Addresses
Displays the local and remote address information.

e Options
Here, you can select the modes FETCH or WRITE.

e Overview
This is an overview of all the configured TCP connections of the selected S7
station with their parameters and the status of the connection.

e Status Information
This tab displays the current status information for the connection (valid at the
time the dialog is opened). This information corresponds to that displayed by
NCM diagnostics.

SIMATIC NET NCM S7 for Industrial Ethernet
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4.6.1

General Tab

This tab in the properties dialog displays parameters for the connection and the

Specifying the TCP Connection Partner

local connection name of the TCP connection.

The local ID is identical to the ID in the NetPro connection table (STEP 7
connection configuration) and is shown here to illustrate the assignment.

Properties - TCP connection

General I Addreszes Iljpti.;.ngl Dverviewl Statuz Information I

— Connection Endpoint

Local ID [hex):

007 A0S0

M ame: ITCF' connection]0

[ Use far ETP protocal

Yia CF: ||:P 4431 |T - [RO/ST)

Boute... |

[™ Active connection establishment

— Block Parameters

1D

WH1EHT1FFC —LADDR

Cancel

Help

Figure 4-19 Layout of the “General” Tab in the Properties Dialog for TCP Connections
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Attribute Description Access
Connection Endpoint
Local ID Identical to the value from the connection list Selectable
Name Proposed name plus suffix connection number that can be Modifiable
changed by the user (max. 24 characters).
Via CP If the station contains more than one CP of the same type Display only
connected to the same subnet, you can select the connection
route —> “Route”, see Section 4.8.
If no CP is assigned (for example because the CP has been
deleted) “none” is displayed here.
Active Connection With this option, you specify whether the connection is Modifiable
Establishment established by this S7 station. This is the default setting when
the address of the partner is specified.
If you selected partner “unspecified” when you created the
connection, the option is deselected as default. If you activate
the option, you must also specify the address of the partner in
the “Addresses” tab.
ON: the connection is established actively.
OFF: the connection is established by the partner.
"Use for FTP protocol” Select this option to configure an FTP connection. Using an Can be

Option

FTP connection, you can access an FTP server from the user
program on the S7—CPU using special FCs.

Requirement: The option can only be selected for an
unspecified TCP connection.

You can configure up to 10 FTP connections.
Selecting the option has the following effects:
® The TCP connection is now used as an FTP connection.

* "Addresses” tab: The addresses are specified automatically
(Port=21)

* "Options” tab: The mode is set to FTP and cannot be
changed.

* The "Active connection establishment” option is irrelevant
and cannot be set.

selected for
an
unspecified
TCP
connection

Block Parameters

ID

This value must be entered as a block call parameter ID for
calling the FC in the user program to identify the connection.
The ID changes if the local ID is changed.

Display only

LADDR

This value must be entered as a block call parameter ID for
calling the FC in the user program to identify the connection.

Display only

4-38
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4.6.2 Specifying TCP Addresses

Address Parameters and Connection Types

With TCP, the communication partners are addressed by the local and remote
endpoints as follows:

e Local addresses:
Local IP address and local port

¢ Remote addresses:
Remote IP address and remote port

— Ethernet station A ( Ethernet station B —

remote *

- * TCP

connection remote
=™

IP IP
address A address B

O
o
=k

Y
U

Figure 4-20 Sending and Receiving on One TCP Connection

Depending on the required connection type, the remote address parameters are
either specified or left open during configuration.

e Specified TCP connection
You specified a destination station when you created the connection.
¢ Unspecified TCP connection

You entered “unspecified” for the connection partner when you created the
connection.
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Addresses Tab — Specified TCP Connection

The addresses tab displays proposed values for the relevant local and remote
address information. You can change the port settings individually.

Propertiez - TCP Connection |

General Addreszes | Dptiu:unsl Dvewiewl Statusz Information I

The portz are walid in the range from 1 to 65535,
& value higher than 1024 iz recommended zince the well-known ports are
lozated in the range up to 1024,

Local Remote

IP [dec): 140.80.0.2 I'I 40.80.0.3

PORT [dec): Im |2EIEIEI

Cancel Help

Figure 4-21  Layout of the Properties Dialog in the “Addresses” tab with DEFAULT Ports for TCP
Connections

Ports

The ports or port addresses define the access point to the user program within the
station / CPU. They must be unique within the station / CPU!

The following table shows the range of values:

Table 4-4

Application / Note Port Addresses
Fixed, must not be used! 0
Assigned as default, should not be used (well-known ports) 1to 1024
Range used by NCM in which a free port address is from 2000 to 5000

searched for and assigned.
You can set any port address within this range.

Port addresses higher than 5000 are used by the system! from 5000...65535

SIMATIC NET NCM S7 for Industrial Ethernet
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Addresses Tab — Unspecified TCP Connection

If you select the partner type as “unspecified”, depending on your intentions, you
can enter address information about the communication partner here. The options
available to you are explained in detail in Section 4.3.1.

The Addresses tab shown here illustrates the situation in which the remote port but
not the IP address was specified. If you make no further entries, you are accepting
connection establishment with any communication partner that uses the specified
port.

Propertiez - TCP Connection |

| Dptiu:unsl Dvewiewl Status |nformation I

General

The portz are walid in the range from 1 to 65535,
& value higher than 1024 iz recommended zince the well-known ports are
lozated in the range up to 1024,

Local Remote

|P [dex]: 140.80.0.2 |

PORT [dec): |2EIEI'I |2I:II]3

Cancel Help

Figure 4-22
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4.6.3 TCP with the FETCH/WRITE Mode

Using FETCH PASSIVE / WRITE PASSIVE

If you select one of the FETCH PASSIVE or WRITE PASSIVE modes for the TCP
connection, you can access the system areas on a SIMATIC S7 PLC from a
SIMATIC S5 station or other non-S7 station.

Propertiez - TCP Connection E3

General I Addresses Dptiﬂml Dvewiewl Statuz Information I
Local Remote
Operating mode: | Fetch passive j ISend.-"Hecv j

Send.-"H B

Cancel Help

Figure 4-23

The connection can then only be used for this mode; sending or receiving with the
FCs AG_SEND/AG_LSEND or AG_RECV/AG_LRECYV is then no longer possible.

The connection establishment is passive; in other words, only the partner station
(SIMATIC S5 station or other non-S7 station) can establish the connection. The
setting is made automatically in the “General” tab and cannot be changed.

« FETCH

If you select the FETCH mode, you allow direct read access to system memory
on the SIMATIC S7 PLC. Such access can be, for example, from a SIMATIC
S5 station or other station.

* WRITE

If you select the WRITE mode, you allow direct write access to system memory
on the SIMATIC S7 PLC. Such access can be, for example, from a SIMATIC
S5 station or other station.

SIMATIC NET NCM S7 for Industrial Ethernet
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Note

If you select this configuration for an S7-300, remember that a connection
resource (free connection for S7 Functions) of the S7-300 CPU is used! CPU
connection resources are also used, for example, by S7-300 CPs, in the FMS
mode or by PGs and OPs. For more detailed information about the maximum
connection resources, refer to /12/ and /6/.

System Memory

You can access the following address areas in the system memory on the
SIMATIC S7 PLC using FETCH or WRITE:

e Data blocks (DB)
(When accessing DBs, remember that the highest DB number is 255.)
e Bit memory (M, MB, MW, MD)
e Process image input table (I, 1B, IW, ID)
e Process image output table (Q, QB, QW, QD)
e |/O area inputs (PIW, PID, PIB)
¢ |/O area outputs (PQW, PQD, PQB)
e Counters (C)
e Timers (T)

Links to Other Systems

The FETCH and WRITE modes supported on ISO transport connections and
ISO-on-TCP or TCP connections can be used with any other device to access the
S7 system memory areas.

To be able to use this type of access, for example for PC applications, you need to
know the PDU structure of the jobs. The required S7 or S5 headers for request
and response frames are 16 bytes long and their structure is described in the
Appendix.

Messages in the Diagnostic Buffer

As a result of FETCH/WRITE access, negative acknowledgments from the S7
CPU are possible. This then leads to corresponding connection-oriented entries in
the diagnostic buffer that you can read out with NCM Diagnostics (see Section
6.5).
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4.6.4 Checking TCP Connection Properties

Overview Tab

The overview shows all the previously configured TCP connections and their
parameters (cannot be modified here).
You can adjust the width of the columns in the table.

Propertiez - TCP Connection |

General | Addresses| Options  Overview | Status Information |
Connections:
Local I | Connh. name | R4S | R emote addressl Local PORT | F
o001 A021 TCP-Werb... 047 2000
0004 4021 TCP-Werb... 047 20m
0005 A021  TCP-Werb... 047 140.80.0.3 2002
000a A0B0  TCP-Werb... nsa 140.80.01 2003

.| | i

™ Display connections of all CPUs

Frint Configuration | Prrirt |

Cancel | Help |

Figure 4-24  Layout of the “Overview” Tab in the Properties Dialog for TCP Connections

Parameter Description

Local ID This is the connection ID of the TCP connection (STEP 7 connection
configuration; DWORD)

Conn. Name Entered connection name It identifies the TCP connection (8
character double width).

R/S Rack/slot of the local CP via which the connection is
established.

Remote Specifies the remote IP address of the connection.

address

Local port Local port (8 characters default length)

SIMATIC NET NCM S7 for Industrial Ethernet
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Parameter

Description

Remote port

Status

Remote port (8 characters default width)

The status displays the current configuration status of the connection.

“Connections without assignment” are indicated by “No local CP/No
remote CP” in the status column and a “!” character at the end of
the“Local ID” (for example: 0002 A0QO!).

Connections you are currently editing are also indicated by “!” at the
end of the local ID.

Connection Overview with Multiple CPUs in an S7 Station

If you operate more than one CPU in your S7 station, you can click the button to
extend the overview to the connections on all CPUs.

SIMATIC NET NCM S7 for Industrial Ethernet
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4.7 Configuring UDP Connection Properties

Introduction

After the entry in the connection table, you can modify specific connection
parameters for each configured connection that were given default values when
you created the connection.

Calling the Dialog
To call the dialog for special connection properties, follow the steps outlined below:
1. Select the required connection in the connection table.
2. Select the menu option Edit » Object Properties

Result The “Properties — UDP Connections" dialog appears.

Tabs
The following tabs are available for UDP connections:

e General
Displays the parameters of the connection and the local name of the UDP
connection.

e Addresses
Displays the local and remote address information.

e Overview
Overview of all configured UDP connections of the selected S7 station with
corresponding parameters and the status of the connection.

e Status Information
This tab displays the current status information for the connection (valid at the
time the dialog is opened). This information corresponds to that displayed by
NCM diagnostics.

SIMATIC NET NCM S7 for Industrial Ethernet
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4.7.1 Specifying UDP Connection Partners

General Tab

This tab of the Properties dialog displays the parameters of the connection and a
local connection name for the UDP connection.

The local ID is identical to the ID in the NetPro connection table (STEP 7
connection configuration) and is shown here to illustrate the assignment.

Propertiez - UDP Connection |
General | ,&,ddreggegl I:Iptigngl Dwerview I Status |nformation I
— Connection Endpaint — Block Parameters

Local 1D [hex):

a—Il

Neme:  UDPVerbindung 9 WiH1GH1FFC —{LADDR

Yia CP: ||:F- 443-1 - [RO/57]

Route... |

Cancel Help

Figure 4-25 Layout of the “General” Tab in the Properties Dialog for UDP Connections
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Attributes Description Access

Connection Endpoint

Local ID Identical to the value from the connection list Selectable

Name Proposed name plus suffix connection number that can be Modifiable
changed by the user (max. 24 characters).

Via CP If the station contains more than one CP of the same type Display only
connected to the same subnet, you can select the connection
route —> “Route”, see Section 4.8.

If no CP is assigned (for example because the CP has been
deleted) “none” is displayed here.

Block Parameters

ID This value must be entered as a block call parameter ID for Display only
calling the FC in the user program to identify the connection.
The ID changes if the local ID is changed.

LADDR This value must be entered as a block call parameter ID for Display only
calling the FC in the user program to identify the connection.

SIMATIC NET NCM S7 for Industrial Ethernet
4-48 C79000-G8976-C129/04




Configuring Communication Connections

4.7.2

Specifying UDP Addresses

Address Parameters and Connection Types

Figure 4-26

With UDP, the communication partners are addressed using the local and remote
endpoint, as follows.

e Local addresses:
Local IP address and local port

¢ Remote addresses:
Remote IP address and remote port

Note

The term “connection” is also used here for UDP. Reason: during configuration
(just as in TCP) the communication partners are assigned to each other and
therefore logically “connected”. In actual fact, with UDP there is no explicit
connection establishment between communication partners.

— Ethernet station A w Ethernet station B —

remote
connection

remote

G ——C®

IP IP
address A address B

Sending and Receiving on One UDP Connection

Depending on the required connection type, the remote address parameters are
either specified or left open during configuration.

e Specified UDP connection
You specified a destination station when you created the connection.
¢ Unspecified UDP connection

You entered “unspecified” for the connection partner when you created the
connection.

e Connection to all Broadcast Nodes

If you select the connection type “Connection to all broadcast nodes”, you
specify that UDP frames are sent to all obtainable broadcast nodes.
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Addresses Tab — Specified UDP Connections

The addresses tab displays proposed values for the relevant local and remote
address information. You can make the settings for the ports individually.

Propertiez - UDP Connection |

General Addreszes | Dptiu:unsl Dvewiewl Statusz Information I

The portz are walid in the range from 1 to 65535,
& value higher than 1024 iz recommended zince the well-known ports are
lozated in the range up to 1024,

Local Remote

IP [dec): 140.80.0.2 I'I 40.80.0.3

PORT [dec): Iﬁm |2EIEIEI

Cancel Help

Figure 4-27 Layout of the Properties Dialog in the “Addresses” tab with DEFAULT Ports for UDP
Connections

Ports

The ports or port addresses define the access point to the user program within the
station / CPU. They must be unique within the station / CPU!

The following table shows the range of values:

Table 4-5
Application / Note Port Addresses
Fixed, must not be used! 0
Assigned as default, should not be used (well-known ports) 1to 1024
Range used by NCM in which a free port address is 2000... onwards
searched for and assigned.

SIMATIC NET NCM S7 for Industrial Ethernet
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Addresses Tab — Unspecified UDP Connection

An unspecified UDP connection can be used in two ways:

Free UDP Connection

To configure a free UDP connection, select the “Address assignment in block”

check box. The input boxes for the remote IP address and the remote port are
then deactivated since the destination addresses are now specified by the user
program.

Connection to a remote station in a different project

You can specify the remote IP address and the port for any destination station.
The destination station can be in the current or a different STEP 7 project.

Please note:

Since no connection is actually established with UDP (datagram service),
communication on the configured UDP connection is only possible when the
partner addresses (IP address and port ) are specified.

Propertiez - UDP Connection |
General Addreszes | Dptiu:unsl Dvewiewl Statusz Information I

The portz are walid in the range from 1 to 65535,
& value higher than 1024 iz recommended zince the well-known ports are
lozated in the range up to 1024,

Local Remote

P [dec): 140.80.0.2 |

—

PORT [dec):

W Address azsignment in block

Cancel Help

Figure 4-28 Layout of the Properties Dialog in the “Addresses” Tab for the “Free UDP Connection” Mode
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Addresses Tab — Connection to all Broadcast Nodes

If you select the connection type “Connection to all broadcast nodes”, you specify
that UDP frames are sent to all obtainable broadcast nodes.

In the “Addresses” tab, a valid broadcast address in the network is proposed for
the partner under the IP address (IP).

You must enter a PORT address suitable for all partners you want to reach under

PORT.
Properties - UDP connection |
General Addresses | Dptiu:unsl Owerview I Status Informatian I

The portg are valid in the range from 1 to 65536,
& walue higher than 1024 iz recommended zince the well-known ports are
lozated in the range up ta 1024,

Local Femote

|P [dec) 140.800.1

PORT [dec]: |2uuu

Cancel Help

Figure 4-29 Layout of the Properties Dialog “Addresses” Tab for the “Broadcast” Mode
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4.7.3 Checking the Properties of a UDP Connection

Overview Tab

At the overview level, all the configured UDP connections and their parameters in
this station are displayed (cannot be modified).
You can adjust the width of the columns in the table.

Propertiez - UDP Connection |
General | Addresses| Options  Overview | Status Information |
Connections:
Local I | Connh. name | R4S | R emote addressl Local PORT | F
0006 A021  UDP-er... 047 140.80.0.3 2003
0007 A021 1 UDP-er... 047 2004
000z a021  UDP-er... 047 140.80.0.3 2000

<]

| 2

™ Display connections of all CPUs

Frint Configuration | Prrirt |

Cancel | Help |

Figure 4-30 Layout of the “Overview” Tab in the Properties Dialog for UDP Connections

Partner address
Local port
Remote port

Status

Parameter Description
Local ID This is the connection ID of the UDP connection (STEP 7 connection
configuration; DWORD)
Conn. Name Entered connection name This identifies the UDP connection (8
characters default length).
R/S Rack/slot of the local CP via which the connection is

established.

Specifies the remote IP address of the connection.

Local port (8 characters default length)

Remote port (8 characters default width)

The status displays the current configuration status of the connection.
“Connections without assignment” are indicated by “No local CP/No
remote CP” in the status column and a “!” character at the end of
the“Local ID” (for example: 0002 A0QO!).

Connections you are currently editing are also indicated by “!” at the
end of the local ID.

SIMATIC NET NCM S7 for Industrial Ethernet
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Connection Overview with Multiple CPUs in an S7 Station

If you operate more than one CPU in your S7 station, you can click the button to
extend the overview to the connections on all CPUs.

SIMATIC NET NCM S7 for Industrial Ethernet
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4.7.4 Free UDP Connection

Program-Controlled Addressing

A free UDP connection allows program-controlled addressing of the
communication partner. Communication between two nodes on Industrial Ethernet
has the following properties:

e Data transfer is bi—directional; in other words it is possible to send and receive
on the UDP connection at the same time.

e The local node is specified in the configuration. The remote node is entered in
the job header of the job buffer by the user program when it calls AG_SEND.
This allows any node on Ethernet/LAN/WAN to be reached.

e The IP address and the port of the sender can be read from the job header of

AG_RECV.
. e rT *****
SIMATIC S7 station ‘ Ethernet
with Ethernet CP ‘ node

User data area | (unspecified)

Job buffer send |:e:> receive

| unspecified

\

\

\

\

\

UDP ti |

Job header connection ‘
receive <: send |
\

\

\

\

\

\

User data

Figure 4-31 Sending and Receiving on an Unspecified UDP Connection with Programmed Addressing

Amounts of Data

Refer to the product information /1/ accompanying the Ethernet CP for the number
of UDP connections supported by the Ethernet CP. The number of connections per
station can be increased by adding more CPs.

Up to 2042 bytes of user data can be transferred per job buffer. The job header
uses an additional 6 bytes.

SIMATIC NET NCM S7 for Industrial Ethernet
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4.8 Routing to Distribute Load

Routing to Distribute Load

If more than one CP of the same type exists in a station and is connected to the

same subnet, the route can be selected.

Click the “Route” button in the “General” tab to display the route dialog:

Local

Partrer

ISIMATIE 400-Station[1)sCRU414-1(1)

ISIMATIE 400-Station(Z)WCRUA14-1(1)

Via CP: |CP 4431 - [RO/54)
Interface Type:  |ndustrial Ethernet
Mode

Address: [18.00.06.01.00.00
Subnet : Ethernet (1]

2 for 4431 Rossy

43-1 - [R0/54]
CP 4431 - [RO/ST)

08.00.06.01.00.0

Cancel Help

If you have configured a load distribution on two or more Ethernet CPs at the local
or remote end, you can assign the connection to the required route via the CP.

Parameter Description
Via CP / Local | If more than one Ethernet CP exists in the station via which connections operated you
can select route here.
The CPs are only displayed for selection if they are networked.
If no CP is assigned (for example because the CP was deleted previously) “(None)” is
displayed here.
If there is only one CP plugged into the station, no selection is possible.
Via CP / Depending on the local selection, the possible remote CPs are displayed. All the CPs
Partner connected to the same subnet (networked) and the local CP can be selected.
(remote) Alternatives are only available when a connection is established to a remote station

configured in the same project and the remote station has two or more CPs.

If there is no CP assigned on the partner (for example because the CP was deleted
previously) “None” is displayed here.

If there is only one CP in the remote station, no selection is possible.

If the partner is an “other station” or SIMATIC S5 PLC, one or more attachments are
displayed for selection depending on the configuration and networking of the station. [_]
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Programming Functions (FCs) 5

Ready-made blocks form the interface to some of the communications services
available with the Ethernet CPs. This chapter includes a detailed description of
these blocks.

The description of each FC includes the following sections that may be extended
by specific information:

Meaning

Call Interface

How the Block Works

Explanation of the Formal Parameters

Condition Codes

This chapter provides you with information over and above the general information
available in the online help for the FCs when programming in STEP 7.

Sample programs:

Sample configurations and programs are available for the SEND/RECEIVE
interface described here:

In the sample project PROJECT_ETHERNET that you can start immediately
after installing NCM S7; for a description, refer to the Primer /2/.

On the Internet as downloadable sample projects; refer to the information in
Appendix C “Support and Training”.

The Quick Start CD that can be ordered separately is a
treasure-trove of sample programs and configurations.

You can order this directly on the Internet at:
http://www.ad.siemens.de/net/html_00/online_zugreifen.htm

SIMATIC NET NCM S7 for Industrial Ethernet
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5.1

General Notes on FCs

Block Library

The functions (blocks of the type FC) described here are supplied with the
standard STEP 7 package.

The following list shows the numbers of the FCs as they are supplied with the
configuration tool. You can change these numbers. You will also find the following
information on the block library in the SIMATIC Manager:

+ SIMATIC_NET_CP

These blocks are available after installing the NCM S7 for Industrial Ethernet
option. Please note that you must use different FCs for the S7-300 and S7-400.

5-2

FC Type 2 SIMATIC Manager Library
SIMATIC_NET_CP
CP 300 CP 400
FC5 AG_SENDY X X
FC6 AG_RECVYD X X
FC7 AG_LOCK X X
FC8 AG_UNLOCK X X
FC50 AG_LSENDY X X
FC60 AG_LRECVD X X
1) Note:

The functions FC50 (AG_LSEND) and FC60 (AG_LRECYV) can be used with
PROFIBUS CPs as an alternative to FC5 and FC 6. There is no difference in the
interface or the way they function. With Industrial Ethernet, the FCs AG_LSEND
and AG_LRECYV can be used to transmit longer data records (>240 bytes to 8
Kbytes). If you use these FCs to transmit larger amounts of data with Ind.
Ethernet, you can also use these blocks for PROFIBUS. Ideally, you should use
these FCs for new applications! On PROFIBUS, however, even if you use these
FCs, you can still only transmit data records up to a maximum of 240 bytes.

2) Note:

The following descriptions also include information on differences between the
various block versions. Please remember to check the version identifiers of the
subfolders in the SIMATIC_NET_CP block library and the version identifiers of the
blocks themselves. The subfolders CP 300 and CP 400 both contain the new block
versions. You will find older versions of the FCs in separate block folders labeled
with the appropriate version identifiers.

SIMATIC NET NCM S7 for Industrial Ethernet
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Examples

Apart from the sample calls in this chapter, after you install NCM S7, you will find
samples in the SIMATIC Manager that you can use directly. These examples are
explained in the Primer /3/.

SIMATIC NET NCM S7 for Industrial Ethernet
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5.2

5.2.1

5-4

Setting Parameters for FC Calls

Before describing the FCs in detail, a few general comments on calling and setting
parameters for FCs will be useful in this point.

It is possible to make the following general statements about the following
parameter groups that occur in all FCs:

e Parameters for CP and connection assignment (input parameters)
e Parameters for specifying a CPU data area (input parameters)

e Status information (output parameters)

Note

Calling FCs in the user program: Please note that FCs of one type (for
example, AG_SEND) must not be called at the same time in different priority
classes (OBs). The reason for this is that an FC does not have an interrupt lock.

Parameters for CP and Connection Assignment (input
parameters)

When you call an FC, you transfer the module base address of the Ethernet CP in
the LADDR parameter (see /5/).
Querying the CP Address

You can find out the module base address using the information in /5/ about
slot-oriented address assignment for signal modules. The information about analog
modules applies to the Ethernet CP.

When configuring the CP with the S7 hardware configuration function, the module
base address is displayed in the configuration table.

SIMATIC NET NCM S7 for Industrial Ethernet
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Setting Block Parameters Automaticallyl)

To ensure correct parameter settings for the block calls, The LAD/STL/FBD editor
in STEP 7 provides you with the option of accepting all the relevant parameters
from the hardware configuration (HW Config) and from the connection
configuration.

When assigning the parameters for the block in the user program, follow the steps
outlined below:

1. Select the block call and its block parameters;

2. Select the menu command “Connections...” with the right mouse button.

3. Depending on the block type, you can now select the connection intended for
the block or module from a list.

4. Confirm your selection; as far as possible, the available parameter values are
entered in the block call.

Response to Incorrect Addresses

If the S7 CPU cannot communicate with the Ethernet CP using the specified
module base address, this is indicated as shown in the table below.

Note

The Ethernet CP is addressed by the SIMATIC S7 PLC as an analog module. This
means that if the addressing is incorrect, error messages occur that cannot be
indicated by the FCs themselves.

Cause Reaction / Code
The CP address points to a hon-existent | CPU remains in the STOP mode due to a
CP module or to a digital module. system error.
The CP address points to a module with | Possible error codes in STATUS:
analog I/Os. 8184H System error
80BOH Module does not
recognize data
record.
80COH Data record cannot
be read.
80C3H Resources
occupied (memory).
80D2H Logical base address
wrong.

1). This function is possible only with the block library ..V5.0 SP3 or later.
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5.2.2

Parameters for Specifying a CPU Data Area (input parameters)

Specifying the Data Area on the CPU

5.2.3

When you call an FC, you transfer the address and length of the data area on the
CPU in which the user data are available or will be stored or which can contain
further parameter information.

The ANY pointer data type is used to address this area. For more detailed
information on this data type, refer to the STEP 7 online help under the topic
“Format of the Parameter Type ANY”. You will also find a detailed description of
the ANY point in /20/.

Status Information (output parameters)

For status evaluation, the following parameters must be evaluated in the user
program:

e DONE or NDR

These parameters (DONE with send jobs and NDR with receive jobs) signal
(successful) completion of the job.

¢ ERROR
This indicates that the job could not be executed error-free.
e STATUS

This parameter supplies detailed information about the execution of the job.
Status codes can be returned during execution of the job (DONE=0 and
ERROR=0).

Evaluating Status Codes

Remember that the status codes DONE, NDR, ERROR, STATUS are updated at
each block call.

Status Codes during CP Startup

5-6

With a complete restart or restart of the Ethernet CP (after activating a switch on
the module), the output parameters of the FC are reset as follows:

e DONE=0

e NDR=0

e ERROR=0

e STATUS = 8180y for AG_RECV and 8181y for AG_SEND

SIMATIC NET NCM S7 for Industrial Ethernet
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5.3 FCs for Configured Connections

Overview
To transfer data on configured connections, you can use the following FCs:
FC Meaning
AG_SEND (FC5) For sending data <= 240 bytes
AG_RECV (FC6) For receiving data <= 240 bytes
AG_LSEND (FC50) For sending datal)
AG_LRECV (FC60) For receiving datal)
1

Newer versions of the Ethernet CP can transmit larger data areas. Please read the
product information bulletin / manual /1/ of the CP to find out which data area is
supported.

Application

The following diagram illustrates the use of the FCs described here for
bi—directional data transfer on one configured connection.

T ‘ 1
CPU ! Ethernet CP EthernetCP ! CPU
STEP7 : STEP7
user ; X user
program : : program
User data : , User data
areas X X areas
AG_SEND : send [, . _—receive | —[ AG RECV
: Connection !
AG_RECV la—receive < <1 send <¢— [AG_SEND
L | ' ]
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Note

Unless specifically stated otherwise, the information on this and the following
pages refers to AG_SEND / AG_LSEND or AG_RECV / AG_LRECW.

Specifying the Data Area on the CPU

When you call an FC, you transfer the address and length of the data area in the
CPU. Remember, that the maximum length of the data area depends on the block
type being used.

e AG_SEND and AG_RECV
With these blocks, you can send or receive up to 240 bytes.
e AG_LSEND/AG_LRECV

Newer versions of the Ethernet CP can transmit larger data areas. Please
check the length of the data area in the product information.

The following table shows the limit values of the various connection types.

Table 5-1
ISO Transport ISO-on-TCP TCP UDP
AG_LSEND 8192 bytes 8192 bytes 8192 bytes 2048 bytes
AG_LRECV 8192 bytes 8192 bytes 8192 bytes 2048 bytes
Note

Transfer of more than 240 bytes of data is supported by newer CP versions. For
detailed information, refer to the Product Information bulletin of your Ethernet CP.

Working without the Job Header

On specified connections, the address and job parameters are specified by the
connection configuration. The user program only provides the user data in the UDP
data area when sending with AG_SEND / AG_LSEND or receives the data with
AG_RECV / AG_LRECV.

SIMATIC NET NCM S7 for Industrial Ethernet
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Working with the Job Header

Free UDP connections require a job header in the user data area.

The following schematic illustrates the structure of the job buffer and the meaning

and location of the parameters in the job header.

User data area

Job buffer Port EBy (low byte) | 034 (high byte) Bytes 0,1
IP address 8EH 0By Bytes 2,3
Job header 28y 23y
Bytes 4,5
—_—
User data [ Data byte 0 | Data byte 1 [ Bytes 6,7
] Bytes
\| Data byte 2040 | Data byte 2041 | 2046 2047
Figure 5-1  Sending and Receiving on a Free UDP Connection with Programmed Addresses

In the picture (entries in hexadecimal) the following IP address is assumed:
142.11.40.35 (example only);

For the port address 1003, the following would be entered: for low byte: EBy;
for high byte: 03y

The user data area can be up to 2048 bytes long. Up to 2042 bytes of user data
can be transferred. 6 bytes are reserved for the job header.

Please note that the data length specified in the block call (LEN parameter)
must include the header and the user data!

SIMATIC NET NCM S7 for Industrial Ethernet
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5.3.1 FCs AG_SEND / AG_LSEND (FC5 / FC50)

Meaning of the Block

FC AG_SEND / AG_LSEND transfers data to the Ethernet CP for transmission on
a configured FDL connection.

The selected data area can be a process image area, a memory bit area or a data
block area.

Error-free execution of the function is indicated when the entire user data area
could be sent on Ethernet.

Note:
Unless otherwise stated, all the following information applies to both the FCs
AG_SEND and AG_LSEND.

Call
Call interface in LAD representation
AG_SEND / AG_LSEND
BOOL DONE BOOL
INT ERROR BOOL
WORD LADDR STATUS WORD
ANY SEND
INT LEN
Example in STL representation
STL Expl anati on
call fc 5 /1 AG_SEND / AG_LSEND bl ock call
ACT = M 10.0
ID = MV 11
LADDR = W£16#0100 =LADDR 256 dec. in hardware configuration
SEND = P#db99. dbx10. 0 byte 240
LEN = MV 12
DONE = M 10.0
ERROR : = M 10. 7
STATUS : = MV 14
Note

Only FC AG_LSEND can be used for TCP connections!

SIMATIC NET NCM S7 for Industrial Ethernet
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How the Block Works

The following diagram illustrates the normal sequence of data transmission
triggered in the user program using AG_SEND.

Each AG_SEND job in the user program is acknowledged by the Ethernet CP with
an entry in the output parameters DONE, ERROR and STATUS.

User program Ethernet CP Communications Partner
(CPU cycle)
T . .
Supply AG_SEND with
data “X”
ACT=1
AG_SEND >
<« 008181
Transfer
Supply AG_SEND “x”
ACT =0 active on
Ethernet
< 0.0,81811)
<10, 00001
Time Time Time

Legend:
1) parameter transfer DONE, ERROR, STATUS

The status code is updated at each block call. To update the status code without a
new send job, the parameter ACT=0 must be set.

SIMATIC NET NCM S7 for Industrial Ethernet
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Explanation of the Formal Parameters

The following table explains all the formal parameters for the AG_SEND

/AG_LSEND functions.

Parameter | Declara- | Type Possible Remarks
tion Values
ACT INPUT BOOL 0,1 If ACT=1, LEN bytes are sent from the ISO
transport data area specified with the SEND
parameter.
If ACT=0, the status codes DONE, ERROR
and STATUS are updated.
ID INPUT INT 1,2...64 The connection number of the connection is
(S7-400) specified in the parameter ID. (see
1,2..16 Configuration Section 4.3.1)
(S7-300)
LADDR INPUT WORD Module base address
When you configure the CP with STEP 7
hardware configuration, the module base
address is displayed in the configuration table.
Specify this address here.
SEND INPUT ANY Specifies the address and length.
The address of the ISO transport data area
references either:
— Process image area
— Bit memory
— Data block area
LEN INPUT INT On ISO Number of bytes to be sent from the ISO
Transport and | transport data area with this job. The possible
ISO-on-TCP / values range from 1 to length specified for the
TCP: SEND parameter.
1,2, to 32767 * Remember the block type:

(or up to “length
specified for
SEND
parameter”)

On UDP:
1,2,...2048 (or
up to “length
specified for
SEND
parameter”)

With the FC AG_SEND, the data area is
normally restricted to a maximum of 240
bytes.

* Note on S7-300:
A data transfer with LEN>240 bytes is only
possible when the Ethernet CP was
configured for this in the Properties dialog!
(see Section 2.2.4)

* Note on the S7-400:
Data transfer may be restricted to
LEN<=240 bytes with older versions of the
CP firmware!
For further information, see /1/

* Improved performance with shorter data
records:

Transfer of data records up to 240 bytes
results in better performance!

5-12
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Parameter | Declara- | Type Possible Remarks
tion Values
DONE OUTPUT BOOL 0: Job active This parameter indicates whether or not the job
1: done was completed without errors.
As long as DONE = 0, no further job can be
triggered. DONE is set to 0 by the CP when it
accepts a new job.
For the meaning of this parameter in
conjunction with the ERROR and STATUS
parameters, refer to the following table.
ERROR OUTPUT BOOL 0: - For the meaning of this parameter in
1: error conjunction with the DONE and STATUS
parameters, refer to the follow table.
STATUS OUTPUT WORD | see following Status code
table The following table shows the codes formed by
the DONE and ERROR parameters.
Condition Codes

The following table shows the condition codes formed by the DONE, ERROR and
STATUS parameters that must be evaluated by the user program.

Table 5-2 AG_SEND / AG_LSEND Codes

DONE ERROR STATUS Meaning

1 0 0000~ Job completed without error.

0 0 0000~ No job being executed.

0 0 8181n Job active.

0 1 7000u This code is possible only with the S7-300: the FC was called
with ACT=0; the job has not yet been processed.

0 1 8183w No configuration or the ISO transport service has not yet started
on the Ethernet CP.

0 1 8184n System error.

0 1 8185w LEN parameter longer than SEND source area.

0 1 8186+ ID parameter invalid. 1D!=1,2 to 64.

0 1 8301x SAP not activated on destination station.

0 1 83021 No receive resources on the destination station; the receiving
station cannot process received data quickly enough or has not
prepared any receive resources.

0 1 8303w The SDA service (Send Data with Acknowledge) is not supported
on this SAP of the destination station (no SDA with Ethernet).

0 1 8304+ The connection is not established. The send job should only be
attempted again after waiting for at least 100 ms.

SIMATIC NET NCM S7 for Industrial Ethernet
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Table 5-2 AG_SEND / AG_LSEND Codes
DONE | ERROR STATUS Meaning

0 1 8311k The destination station cannot be obtained under the specified
Ethernet address.

0 1 8312x Ethernet error on the CP.

0 1 8F22+ Source area invalid, for example:
Area does not exist in the DB
LEN parameter <0

0 1 8F244 Area error reading a parameter.

0 1 8F28n Alignment error reading a parameter.

0 1 8F32u Parameter contains a DB number that is too high.

0 1 8F33n DB number error.

0 1 8F3An Area not loaded (DB).

0 1 8F42u Timeout reading a parameter from the I/O area.

0 1 8F44x Address of the parameter to be read is disabled in the access
track.

0 1 8F7Fn Internal error, e.g. illegal ANY reference.
e.g. parameter LEN=0

0 1 8090+ No module with this address exists or the CPU is in the STOP
mode.

0 1 8091+ Logical base address not at a double word boundary.

0 1 80A4H The communication bus connection between the CPU and CP is
not established. (Only with newer CPU versions)

0 1 80B0Ox The module does not recognize the data record.

0 1 80B1x The specified length (in the LEN parameter) is incorrect.

0 1 80B2x The communication bus connection between the CPU and CP is
not established.

0 1 80COx The data record cannot be read.

0 1 80C1n The specified data record is currently being processed.

0 1 80C2n There are too many jobs pending.

0 1 80C3n CPU resources (memory) occupied.

0 1 80C4+ Communication error (occurs temporarily and a repetition in the
user program will often remedy the problem).

0 1 80D2x Module base address incorrect.

5-14
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5.3.2 FC AG_RECV/AG_LRECV

Meaning of the Block

FC AG_RECV / AG_LRECYV accepts the data transferred via a configured
connection from the Ethernet CP.

The data area specified for the receive data can be a process image area, a bit
address area or a data block area.

Error-free execution is indicated when the data could be received from the
Ethernet CP.

Call
Call interface in LAD representation
AG_RECV/AG_LRECV
NDR BOOL
INT - ID ERROR BOOL
WORD — LADDR STATUS WORD
ANY — LEN INT
Example in STL representation
STL Expl anati on
call fc 6 /1 AG_RECV/ AG_LRECV bl ock call
ID = DB 100. DBW 1
LADDR = W£16#0100
RECV = P#M 0.0 BYTE 100
NDR = DB 100. DBX 0. 6
ERROR : = DB 100. DBX 0. 7
STATUS : = DB 100. DBW 2
LEN = DB 100. DBW 4

Note
Only FC AG_LRECYV can be used for TCP connections!
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How the Block Works

The following diagram illustrates the normal sequence of data acceptance
triggered by an AG_RECYV in the user program.

Each AG_RECYV job in the user program is acknowledged by the Ethernet CP with
an entry in the output parameters NDR, ERROR and STATUS.

User program Ethernet CP Communications Partner
(CPU cycle)
. . .
-t
Transfer
“pn
active on
AG_RECV > Ethernet

< 0,1,81801)

AG_RECV >
<« 10,0000 -t
Accept / evaluate Transfer
received data “A” “B”
active on
Ethernet
AG_RECV >
< 0.0.8180D
AG_RECV >
10,0000
Accept / evaluate
received data “B”
-
Transfer
AG_RECV > “cr
active on
Ethernet

VTime v Time VTime
Legend:

1) Parameter transfer NDR, ERROR, STATUS

The status code is updated at each block call.
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Explanation of the Formal Parameters

The following table explains all the formal parameters for the AG_RECV /

AG_LRECYV function.

Parameter

Declara-
tion

Type

Possible
Values

Remarks

ID

INPUT

INT

1,2..16

The connection number of the ISO transport
connection is specified in the ID parameter (see
Configuration Section 4.3.1)

LADDR

INPUT

WORD

Module base address

When you configure the CP with STEP 7
hardware configuration, the module base
address is displayed in the configuration table.
Specify this address here.

RECV

INPUT

ANY

Specifies the address and length.

The address of the ISO transport data area
references either:

— Process image area

— Bit memory

— Data block area

Note on length:

Performance is improved in transfer of data
records up to 212 bytes if you also restrict the
length to 212 with the RECV parameter.

NDR

OUTPUT

BOOL

0: -
1: new data

This parameter indicates whether new data
were received.

For the meaning of this parameter in
conjunction with the ERROR and STATUS
parameters, refer to the following table.

ERROR

OUTPUT

BOOL

0: -
1: error

Error code

For the meaning of this parameter in
conjunction with the DONE and STATUS
parameters, refer to the following table.

STATUS

OUTPUT

WORD

see following
table

Status code

For the meaning of this parameter in
conjunction with the NDR and ERROR
parameters, refer to the following table.

LEN

OUTPUT

INT

On ISO
Transport and
1ISO-on-TCP:

1,2..8192

On UDP:
1,2...2048

Specifies the number of bytes accepted from
the Ethernet CP and entered in the ISO
transport data area.

* Remember the block type:
With the FC AG_RECYV, the data area is
normally restricted to a maximum of 240
bytes.
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Condition Codes
The following table shows the codes formed by the DONE, ERROR and STATUS

parameters that must be evaluated by the user program.

Table 5-3 AG_RECV /AG_LRECV Codes

NDR ERROR STATUS Meaning

1 0 0000~ New data accepted.

0 0 8180w There are not yet any data available.

0 0 8181n Job active.

0 1 8183w No configuration or the ISO transport service has not yet started
on the Ethernet CP.

0 1 8184w System error (the source data area is incorrect).

0 1 8185w Destination buffer (RECV) is too short.

0 1 8186w ID parameter invalid.
ID I=1,2....16 (S7-300).
ID I=1,2....64.(S7-400)

0 1 8304n The connection is not established. The send job should only be
attempted again after waiting for at least 100 ms.

0 1 8F23H Source area invalid, for example:
Area does note exist in the DB.

0 1 8F25n Area error writing a parameter.

0 1 8F29u Alignment error writing a parameter.

0 1 8F30~ Parameter is in the write-protected 1st act. data block.

0 1 8F31n Parameter is in the write-protected 2nd act. data block.

0 1 8F32u Parameter contains a DB number that is too high.

0 1 8F33n DB number error.

0 1 8F3AH Destination area not loaded (DB).

0 1 8F43n Timeout writing a parameter to the 1/O area.

0 1 8F45n Address of the parameter to be read is disabled in the access
track.

0 1 8F7Fn Internal error, e.g. illegal ANY reference.

0 1 8090+ No module with this address exists or the CPU is in the STOP
mode.

0 1 8091+ Logical base address not at a double word boundary.

0 1 80AOH Negative acknowledgment reading from the module.

0 1 80A4H The communication bus connection between the CPU and CP is
not established.

0 1 80B0Ox The module does not recognize the data record.

0 1 80B1n Destination area invalid.

0 1 80B2x The communication bus connection between the CPU and CP is

not established.

5-18

SIMATIC NET NCM S7 for Industrial Ethernet

C79000-G8976-C129/04



Programming Functions (FCs)

Table 5-3 AG_RECV/AG_LRECV Codes
NDR ERROR STATUS Meaning
0 1 80COx The data record cannot be read.
0 1 80C1n The specified data record is currently being processed.
0 1 80C2x There are too many jobs pending.
0 1 80C3n CPU resources (memory) occupied.
0 1 80C4+ Communication error (occurs temporarily and a repetition in the
user program will often remedy the problem).
0 1 80D2x Module base address incorrect.
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54 FCs for Access Coordination with FETCH/WRITE

Overview

For the FETCH/WRITE functions, the following FCs are available for access
coordination:

FC Meaning
AG_LOCK Locks external data access with
FETCH/WRITE.
AG_UNLOCK Releases external data access with
FETCH/WRITE.

Caution when Configuring

If you use FCs AG_LOCK and AG_UNLOCK, you must specify the following
information for S7-400 stations in the configuration:

¢ in HW Config

In the “Addresses” tab, the option “Address setting for LOCK/UNLOCK” must
be selected.

How the Block Works

With these FCs, you can coordinate access to system memory areas so that no
inconsistent data are created and transferred. The control is from the user program
in the S7 CPU that can, if necessary disable an external FETCH/WRITE access
using an AG_LOCK call. After a certain time or after the local write/read access is
completed, an AG_UNLOCK job can be used to enable external access again.

Another advantages is that this access lock only applies to the FETCH/WRITE
connection specified in the call. If more than one FETCH/WRITE connections are
configured, these can, for example, be used for certain specific system areas and
a selective access coordination can be implemented.

The following diagram illustrates the usual chronological sequence of memory
access coordination controlled in the user program with AG_LOCK and
AG_UNLOCK.

SIMATIC NET NCM S7 for Industrial Ethernet
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Cycle n

Cycle n+1

Cycle n+2

Cycle n+m

User program Ethernet CP Communications Partner
(CPU cycle)
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AG_LOCK
= .
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|

VTime

\ Data
processing
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AG_UNLOCK
=
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{ > TATYUS = 700x FETCH/WRITE
access to DB x
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\

v Time VTime

The lock job must first be monitored in the user program using the code in the
return parameter LOCKED. As long as LOCKED=0 is indicated, it must be
assumed that there is still a FETCH/WRITE access active.

If LOCKED=1 is indicated, this shows that the lock is active; data can now be

modified by the user program.

The status code is updated at each block call.
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5.4.1 FC AG_LOCK

Meaning of the Block

Using the AG_LOCK block the data exchange using FETCH or WRITE on the
connection selected with the parameter ID is disabled. The LOCKED output
indicates whether or not the lock was successful. If the lock was not successful,
the job must be triggered again in a later CPU cycle.

The STATUS output indicates the status of the CP for this connection.

Call
Representation of the AG_LOCK Function
AG_LOCK
ID STATUS
LADDR LOCKED
Example in STL representation
STL Expl anati on
call fc 7
I D = DB 100. DBW 1
LADDR = W£16#0100
STATUS : = DB 100. DBW 2
LOCKED : = DB 100. DBX 0. 6

Explanation of the Formal Parameters

The following table explains all the formal parameters for the AG_LOCK function:

SIMATIC NET NCM S7 for Industrial Ethernet
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table

Parameter | Declara- | Type Possible Remarks
tion Values
ID INPUT INT 1,2...16 for The connection number of the ISO transport
S7-300 connection is specified in the ID parameter (see
1,2...64 for Configuration Section 4.3.1)
S7-400
LADDR INPUT WORD Module base address
When you configure the CP with STEP 7
hardware configuration, the module base
address is displayed in the configuration table.
Specify this address here.
LOCKED OUTPUT BOOL 0: not (yet) Shows the status of the access lock requested
locked on the specified FETCH/WRITE connection.
1: locked
STATUS OUTPUT WORD | see following Status code

For meaning, refer to the table below.

Condition Codes

The following table shows the STATUS code that must be evaluated by the user

program.

Table 5-4 AG_LOCK Condition Codes

STATUS Meaning
7000 CP is not processing a job
7001 FETCH active
7002 WRITE active
8183 FETCH/WRITE not configured for this connection
8186 ID number not in permitted range (e.g. 1...64 with S7-400 Industrial Ethernet CPs)

SIMATIC NET NCM S7 for Industrial Ethernet
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5.4.2 FC AG_UNLOCK

Meaning of the Block

Using the AG_UNLOCK function, the external access to system areas on the S7
CPU with FETCH or WRITE on the connection specified by the ID parameter is
released.

The next external FETCH/WRITE job to arrive for the CP can then be processed.
The AG_UNLOCK follows an access lock with AG_LOCK.

Call

Representation of the AG_UNLOCK Function

AG_UNLOCK
STATUS

Example in STL representation
STL Expl anati on
call fc 8 DB 100. DBW 1
LADDR = W£16#0100
STATUS : = DB 100. DBW 2

How the Block Works

To release the connection again, the LOCK request bit must be reset by the FC
again. The FC also shows the current status using error messages.

Explanation of the Formal Parameters

The following table explains all the formal parameters for the AG_UNLOCK
function:

SIMATIC NET NCM S7 for Industrial Ethernet
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table

Parameter | Declara- | Type Possible Remarks
tion Values
ID INPUT INT 1,2...16 for The connection number of the ISO transport
S7-300 connection is specified in the ID parameter (see
1,2...64 for Configuration Section 4.3.1)
S7-400
LADDR INPUT WORD Module base address
When you configure the CP with STEP 7
hardware configuration, the module base
address is displayed in the configuration table.
Specify this address here.
STATUS OUTPUT WORD | see following Status code

For meaning, refer to the table below.

Condition Codes

The following table shows the STATUS code that must be evaluated by the user

program.

Table 5-5 AG_UNLOCK Condition Codes

STATUS Meaning
7000 CP is not processing a job
7001 FETCH active
7002 WRITE active
8183 FETCH/WRITE not configured for this connection
8186 ID number not in permitted range (e.g. 1...64 with S7-400 Industrial Ethernet CPs)
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The NCM S7 Diagnostics described here provides dynamic information on the
operating state of the communication functions of online CPs.

This chapter provides a general overview of the individual diagnostic functions.

The following checklist will help you to recognize several typical problems and their
possible causes and shows how you can use the NCM S7 for PROFIBUS
diagnostics tool to remedy the situation.

¢ When you are working with the diagnostic tool, the integrated help system

ﬂ Further information is available from the following sources:
provides you with context-related support.

¢ You will find detailed information on working with STEP 7 programs in the Help
on STEP 7, which includes the topic “Diagnosing Hardware”.
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6.1 Overview

Diagnostic Options in STEP 7

STEP 7 provides you with a graded concept allowing you to query information
about the status of your SIMATIC S7 components and functions and to sort out
problems in a variety of different situations. These options cover the following:

Hardware Diagnostics and Troubleshooting with STEP 7

Hardware diagnostics provides dynamic information on the operating mode of
modules including CPs when the S7 station is online.

You can recognize the existence of diagnostic information for a module by the
diagnostics icon in the project window of the SIMATIC Manager. Diagnostic
icons show the status of the corresponding module and also the operating
mode of CPUs.

Detailed diagnostic information is displayed in the “module information” that you
can open by double-clicking a diagnostic icon in the quick view or the diagnostic
view.

Communication Diagnostics with NCM S7 Diagnostics

The NCM S7 Diagnostics described here provides dynamic information on the
operating state of the communication functions of online CPs.

HW Config Provides Static Information

Static information means the configured communication properties of an online
or offline CP and you can display this at any time using the hardware
configuration shown by HW Config.

What You Should Already Know

You should be familiar with the basic information from Chapter 2 about handling
NCM S7. This means that you know how to connect the Ethernet CP to the PG
and how to control the module using the PG.

Where to Find Further Information
ﬂ Further information is available from the following sources:

6-2

Information about the communication services is available in the appropriate
chapters in this manual.

When you are working with the diagnostic tool, the integrated help system
provides you with context-related support.

You will find detailed information on working with STEP 7 programs in the Help
on STEP 7, which includes the topic “Diagnosing Hardware”.
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6.2 Functions of NCM S7 Diagnhostics

Functions
The diagnostic functions can be grouped as follows:
¢ General diagnostic and statistical functions

¢ Type and mode-dependent diagnostic functions

General Diagnostic and Statistical Functions

Regardless of the configured mode of the Ethernet CP, the following diagnostic
functions are possible:

¢ Querying the operating mode on Ethernet

¢ Querying the event messages recorded on the Ethernet CP (diagnostic buffer)

Mode-Dependent Functions

Depending on the configured mode of the Ethernet CP, the following diagnostic
functions are possible:

¢ Diagnostics of ISO transport connections
¢ Diagnostics of ISO-on-TCP connections
e Diagnostics of TCP connections

¢ Diagnostics of UDP connections

¢ Diagnostics of E-mail connections

SIMATIC NET NCM S7 for Industrial Ethernet
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6.2.1 Installing and Starting NCM S7 Diagnostics

Installation

NCM S7 Diagnostics is an integrated component of the NCM S7 for Industrial
Ethernet optional package.

NCM S7 Ethernet Diagnostics is installed along with NCM S7 for Ethernet on your
PG.

There are several ways in which you can start the diagnostic tool:

Alternative 1 Alternative 2
¢ From the standard Start menu of Win- e From the Properties dialog of the CP within
dows (program group your STEP 7 project.

SIMATIC»...»NCM). I
Use this method if the STEP 7 project ~ _—

in which the CP was configured is not B SN EE e e T A

V11 Eo1 o] [Ro] g Yo ]V | g S C N (o] FS{=TaV/ [N o V| RN 51 H' Config - [SIMATIC 400(1) (Configuration) — COLOR_414]
poses). [ooverior - tp a4t 150 GO
<| 7 General]ﬂdresses' Options  Diagnostics |
1 odule Diaghostic:
’75tart special diagnostics

FS, MCM 57 Industial Ethernet =, MCM 57 Manuals  #
MCM 57 PROFIBUS r Fieadme r
Maotes 3

HNCM 57 Diagnostics: Online Patk

‘Which module do you want to accesy?

-~ Gateway

Gateway attachment: /
[itone) =
Wode address [gateway]| I
S submet [0 of destination network: I o

r~ Destination Station \
Destination station attachment X \7

[MPI/PROFIBUS/2UTOD \/ -

[[_-'T""EP 443-1 Industrial Ethernet - HCM 57-Diagnoze OMLINE

SIMATIC NET NCM S7 for Industrial Ethernet
6-4 C79000-G8976-C129/04



NCM S7 Diagnostics

Structure

In the same way, for example, as the SIMATIC Manager, NCM S7 Diagnostics
appears as a separate two-part application window with a menu and toolbar:

0| dife| T

CP Infarmation

Diagnastic Buffer Erlace 150-40 00.00.00.00,00.00
Operating Mode Enlace IS0-41 00.00.00.00.00.00
=) Connestions Enlace IS0 00.00.00.00.00.00
bl Enlace 150 08.00.05.20.61.CC
Enlace 150-40
Enlace 150-41
Enlace 150
A% Enlace |50
) 150 on TCP
N TCP
&) UDP

Navigation area with %

diagnostic objects

Content area with the
diagnostic result

¢ Inthe navigation area on the left-hand side, you will find the hierarchically
arranged diagnostic objects.

You have an overview of the available diagnostic functions at all times. The
object structure displayed in the navigation area is adapted to the type of CP
you are currently checking and the functions and connections configured for the
CP.

¢ Inthe content area, on the right-hand side, you will see the result of the
diagnostic function you selected in the navigation area.

Working in the Dialog

e By selecting a diagnostic object in the navigation area with the mouse, you
execute the diagnostic function.

e Using the menu bar and toolbar, you control the sequence of the diagnostics
with context-sensitive menu commands.

SIMATIC NET NCM S7 for Industrial Ethernet
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6.2.2 General Menu Commands

Overview

When running diagnostic functions, the following menu commands have general
significance. Depending on the context, other functions may be available; for more
detailed information refer to the online help for NCM Diagnostics.

Table 6-1 Meaning of the Menu Commands

Menu

Meaning

Diagnostics »
Open Online Connection...
Diagnostics »
Close Online Connection...

With this menu command, you can establish a connection to a different CP
you want to check without having to quit and restart the diagnostic tool. The
current diagnostic connection is closed.

If you want to use more than one diagnostic connection at the same time,
you can start NCM S7 diagnostics more than once.

Operating Mode »

You can control the CP as follows:

Stop CP Stops the CP.

Start CP Starts the CP if the RUN/STOP switch is set to RUN.

Reset CP With certain CP types, for example the CP 443-5 Basic, you can reset the
CP memory. This function must be confirmed before it is executed.

View»Update Each time you activate this menu command, the displayed diagnostic and
status information is updated once.

View » Using this menu command, you activate and deactivate the automatic

Update Cyclically

(cyclic off) updating of the displayed diagnostic and status information.

You can set the interval between update points with the menu command
Options » Customize.

Options » Customize

With this menu command, you set the general parameters for the diagnostic
session.

On Ethernet:

* Dialog update time
This sets the interval at which the diagnostic data are updated in a
contents area when cyclic updating is selected.

® Show TSAP in ASCII

You can decide whether the TSAP is shown in ASCII or hexadecimal in
the following tab page dialogs.

Help »

You can obtain help about the current diagnostic function As an alternative,
you can also press the F1 key.

Remember that you can also call up context-related help for some of the
diagnostic functions. To obtain help, position the cursor on the output field
and press the F1 key.

SIMATIC NET NCM S7 for Industrial Ethernet
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Note
If the connection to the CP is terminated during the diagnostic session, the
following message is displayed: “The online connection was terminated”.

You can reestablish the connection to the CP with the corresponding
acknowledgment in the dialog. The connection is then automatically reestablished

whenever possible.
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6.3 Starting Diagnostics — Establishing a Connection to the
Ethernet CP

Initial Situation

Establish the physical connection between the PG and the SIMATIC S7 Station.
There are two ways of doing this:

« MPI

e Industrial Ethernet

e Industrial Ethernet TCP/IP
« PROFIBUS

Starting Diagnostics from the NCM Program Group

If there are no configuration data on your PG/PC, follow the steps outlined below to
start diagnostics with a connected CP:

1. Select the function “NCM Diagnostics” in the NCM S7 program group.

NCM S7 Diagnostics is started with the message “No online connection to the
CP” in the contents area.

2. Select the “Diagnostics»Open Online Connection...” menu command.

3. In the displayed dialog “NCM S7 Diagnostics”, select the interface to match
your hardware configuration.

Depending on the type of network attachment you have, you will be prompted
to specify an address:

Table 6-2 Possible Settings for the Online Paths — without Parameters for Internetworking

Attachment on Node Address Location of the Module
Destination Station Rack / Slot
MPI MPI address of the CP if this has its Rack/slot no. of the CP to be
own MPI address. checked.
Otherwise specify the MPI address of | If you specify the MPI address of the
the CPU. CP, you can simply use the default
setting “0/0".

With this setting, the CP whose
address was specified as the node
address is accessed.

PROFIBUS PROFIBUS address of the Rack/slot no. of the CP to be
PROFIBUS CP via which the S7 checked.
station is reached.

SIMATIC NET NCM S7 for Industrial Ethernet
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Table 6-2 Possible Settings for the Online Paths — without Parameters for Internetworking

Attachment on
Destination Station

Node Address

Location of the Module
Rack / Slot

Industrial Ethernet

MAC address of the Ethernet CP via
which the S7 station is reached.

Entered in hexadecimal.

Rack/slot no. of the CP to be
checked.

If you specify “0/0”, the CP specified
with the node address is accessed
directly.

Industrial Ethernet
TCP/IP

IP address of the Industrial Ethernet
CP via which the S7 station is
reached.

Entered in decimal.

Example:
IP address decimal 142.120.9.134

Rack/slot no. of the CP to be
checked.

If you specify “0/0”, the CP specified
with the node address is accessed
directly.

Internetworking

If the CP you want to check with diagnostic functions can only be reached via a
gateway, you must select the device and specify its node address in the local

network.

You must also specify the S7 subnet ID of the destination network:

The subnet ID consists of two numbers separated by a dash:

— One number for the project

— One number for the subnet

You will find the subnet ID in the object properties of the subnet in the STEP 7
project. The subnet ID is also printed out with the network configuration.

Starting Diagnostics from the Properties Dialog of the CP

If the project data are available on your PG/PC, follow the steps outlined below:

1. Select the S7 station in the project and open the hardware configuration (HW

Config).

2. Select the CP and open the Properties dialog.

3. Select the “Diagnostics” dialog.

4. Select the “Run” button.

Result:

NCM S7 Diagnostics is opened. The path is set automatically to match the current
connection in STEP 7.

SIMATIC NET NCM S7 for Industrial Ethernet
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Other Startup Options
In the Properties dialog of the connections:

1. Select the PLC»Activate Connection Status menu command to activate
online access.

2. Select the “Special Diagnostics” button in the “Status Information” tab.
In the hardware configuration tool HW Config:
1. With the S7 station online, select the PLC»Module Status menu command;

2. Select the “Special Diagnostics” button in the dialog that is opened.

Note

To operate several diagnostic connections at the same time, you can start NCM
S7 Diagnostics more than once.

You can also start NCM S7 Diagnostics twice with an online connection to the
same CP; this can, for example, be useful if you want to monitor the diagnostic
buffer at the same time as running diagnostic functions on a connection.

Requirement: You have an online connection available via the LAN (ISO or
TCP/IP) on the one hand and an online connection via the communication (K) bus
on the other (alternatively via the CPU or via PG channel routing via a further CP).

SIMATIC NET NCM S7 for Industrial Ethernet
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6.4 How to Use Diagnostics

Procedure

To use diagnostics efficiently, particularly when working with the diagnostic tool for
the first time, the following procedure can be recommended.

1. Use the sequence shown below as a basis for using diagnostics:

Begin NCM S7 Diagnostics:

— Establish connection to the CP (Section 6.3

— Make the required settings (See Section 6.2.2))
— ldentify the Ethernet CP

A

Query the current status of the CP
"Operating Mode” tab”

' '

If the CP is not If the CP is in the RUN mode
in the RUN mode

TCP connection

ISO transport connection/
ISO-on-TCP connections
UDP connections

If anything unusual is displayed for
— connection status

—receive status,

—send status

A |

View / evaluate the diagnostic buffer to obtain an overview
and detailed explanation of diagnostic events.

Y

L T T T T T s

If necessary, correct configuration or programming.

2. Pinpoint your problem or task, for example based on the checklist in Section 6.6
and select the diagnostic function you require based on the recommendation in
the list.

SIMATIC NET NCM S7 for Industrial Ethernet
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6.5

Call-Specific Diagnostic Functions

The following table shows the diagnostic options that exist in the available
functions.

Table 6-3 General Diagnostic and Statistical Functions

Diagnhostic
Functions /
Diagnostic Object

Diagnostic Aims

Special Features

CP information

The aim is to identify the CP to which
NCM S7 Diagnostics is connected and
to find out the current mode.

Mode

Here, the aim is to find out the current
operating mode of the Ethernet CP as a
module in the S7-300/400 and as a node
on Ethernet and, if necessary, to modify
the mode (menu command Operating
Mode»Stop CP/Start CP).

Diagnostic buffer

General Error Diagnostics Using
Diagnostic Buffers:

To display and decode event messages
recorded on the CP in detail. The
diagnostic buffer provides you with
detailed information about all the
communication services of the CP.

Event messages are recorded on the CP
in a ring buffer. The ring buffer can
contain up to 50 entries.

In NCM S7, on the other hand, up to 500
messages can be saved!

All the CP functions can generate event
messages. When you call the diagnostic
object, the messages are read out and
displayed. The latest message is
displayed in the top line with the highest
consecutive number.

If you double-click a previously selected

event message, you display a help text
explaining the message in greater detail.

Table 6-4 Mode-Dependent Functions

Diagnhostic
Functions /
Diagnostic Object

Diagnostic Aims

Special Features

Connections

To display and monitor communication connections. You obtain an overview or detailed information in the
contents area depending on the diagnostic object you select.

* Overview of All Connection Types
Used

By double-clicking the objects in the
contents area, you can display detailed
information.
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Table 6-4 Mode-Dependent Functions, continued

Diagnhostic
Functions /
Diagnostic Object

Diagnostic Aims

Special Features

Connections »
Type

Overview of all the communication
connections of a particular type, for
example all TCP connections;

Information on the connection status

Connections »
Type »
Type-connection-n

Detailed information about the status
of a communication connection.

SIMATIC NET NCM S7 for Industrial Ethernet
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6.6 Checklist for ‘Typical Problems* in a System

Meaning
The following lists contain several typical problems and their possible causes and
how you can use the NCM S7 Ethernet Diagnostics tool to remedy the situation.
The checklists deal with the following topics:
1. Checklist for General CP Functions
2. Communication Connections Checklist

Note

In the column “ldentifying the Cause and Remedy”, you will see the diagnostic
function recommended for dealing with the problem shown in bold face.

SIMATIC NET NCM S7 for Industrial Ethernet
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6.6.1 Checklist for General CP Functions

Table 6-5 Checklist for Typical Problems When Operating a CP in a System

Problem

Possible Cause

Identifying the Cause and Remedy

The Ethernet CP will not
change to the RUN mode.

Invalid configuration
loaded on the Ethernet

CP.

Yellow STOP LED and red SF LED lit
continuously.

Call up the diagnostic buffer in NCM S7
Ethernet Diagnostics.

Example of an entry

The maximum number of entries for ISO
transport connections was exceeded
Further entry:

CP STOP due to invalid CP parameter
assignment

What to do:
Correct the configuration of the Ethernet CP.

Switch set to STOP on the

Ethernet CP.

Query the operating mode in NCM S7
Diagnostics.

Operating mode: STOP, Cause: switch set to
STOP

What to do:
Change the switch to RUN on the Ethernet CP

SIMATIC NET NCM S7 for Industrial Ethernet
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6.6.2

Communication Connections Checklist

Table 6-6  Checklist for Typical Problems with ISO Transport / ISO-on-TCP / UDP Connections

Problem

Possible Cause

Identifying the Cause and Remedy

No data transfer on an

ISO transport connection
/
ISO-on-TCP connection
or only in one direction.

AG-SEND and AG-RECV
are not called in the user
program.

or

Receive or send buffer too
small or incorrect.

Check the user program.

Evaluate status bytes in AG-SEND and
AG-RECV.

What to do:
If necessary, configure FC blocks.
If necessary, correct ANY pointer.

The connection is not
established.

Evaluate status bytes of the FC blocks or
evaluate diagnostic buffer.

What to do:
Change the address parameters (MAC/IP
address, TSAP).

Data transfer too slow

Receiving device too slow

Evaluate diagnostic buffer.

Entry: “No receive resources on destination
station XX”.

What to do:

Delay the send trigger or check the destination

station and optimize reception.

The complete data field
is not sent on an ISO
transport /
1SO-on-TCP/UDP
connection.

LEN parameter for
AG-SEND is set to the
wrong value.

What to do:
Set the LEN parameter to the required size.

The complete data field
is not sent on an ISO
transport /
1SO-on-TCP/UDP
connection.

The buffer specified with
the ANY pointer is too
small.

What to do:

Correct the LEN parameter and the ANY pointer.

4
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This chapter will familiarize with the uses and handling of the Firmware Loader.

The firmware loader allows you to download more recent firmware versions to the
SIMATIC NET CPs.
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7.1 Application

Firmware

Here, firmware means the system programs in the SIMATIC NET CPs.

Uses of the Firmware Loader

The firmware loader allows you to download more recent firmware versions to the
SIMATIC NET CPs. It is used on the following:

« PROFIBUS CPs
¢ [Industrial Ethernet CPs

Installation

The firmware loader is available when you have installed NCM on your PG/PC.

Load Files
The firmware loader supports the following file types:
o <file>.LAD

A file form containing only the system program that can be downloaded to the
CP.

o <file>.FWL

A file form that contains information that can be displayed in the dialogs of the
firmware loader in addition to the LAD file form.

For detailed information, read the documentation, for example, the README file
shipped with the load file.

Working with the Firmware Loader

Depending on the CP type, the downloading is prepared and executed in three or
four steps.

For more detailed information, refer to the next section and the dialog boxes
themselves.
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Firmware Loader

7.2 Loading Firmware

Starting the Download

Start the program from the Windows standard Start menu using the SIMATIC
»NCM S7 » Firmware Loader menu command.

¥ SIMATIC NET Firmware Loader [_ =] =]

The SIMATIC MET Firmware Loader is used to load the firmware of
SIMATIC MET CP=

Mew firmware must be loaded when the functions of the firmaare have
been extended or when ermors have been comected. To check whether
pou require an update of your firmware. contact your local SIEMEMS
office.

To load the fimware, follovw the steps as explained and the instructions in
the readme file.

< Back Load I Cancel I Help I

Select the Next button and follow the instructions displayed in the dialog.

1st Step
Select the firmware to be downloaded using the Browse... button.

The text box for selecting files also displays a list box in which the last ten selected
load files are displayed and can be selected.

With FWL load files, the comment box may also contain additional information
about the file.

ii Caution
Make sure that the load file you are using is intended as an update for the version
of the firmware contained on your CP. If you are in any doubt, contact your local
Siemens advisor.
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Firmware Loader

2nd Step

3rd Step

7-4

Select the interface via which you want to download the firmware.

The interface type (PROFIBUS or Industrial Ethernet) is already decided by the
load file you selected.

e For a PROFIBUS CP:
There are no further settings in this dialog; go to the next step.
e For an Industrial Ethernet CP:

Select or specify the MAC address of the Ethernet CP and go to the next step.

Note
The following applies to an Industrial Ethernet CP:

If a download was previously aborted to the particular CP you must click the
Emergency Address button. In this case, it is assumed that there was a memory
reset on the CP which is now only accessible using an emergency address.

With newer CPs (order number 6GK7 x43-1EX11-0XEO and later), a fixed MAC
address assigned to the CP is used instead of an emergency address. Please
refer to the information in the relevant manual /1/ on the topic of “Downloading
New Firmware”.

Check the configuration.

You can check and adjust settings for the PG/PC interface using the Modify...
button.

Set the PG/PC interface according to the CPs available on your PG (list box
“Device Parameter Sets”) and according to the bus attachment (list box
“Properties”).

For more detailed information, refer to the integrated help system.

Continue to follow the instructions in the dialog to establish the connection to the
Ethernet CP.
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ii Caution
Remember that interrupting the download can lead to an inconsistent state on the
CP.

With Industrial Ethernet, please note the instruction in the second step for
displaying the emergency address.

Using the Modify... button, you can set the PG/PC interface back to its original
values.

For more detailed information, refer to the integrated help system.

4
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Glossary

B.1 General Section

Baud rate

—> transmission rate

Bus Segment

Part of a —> subnet. Subnets can consist of bus segments and connectivity
devices such as repeaters and bridges. Segments are transparent for addressing.

Client

A client is a device or, in general terms, an object that requests a service from a —>
server.

Configuration Data

Parameters that determine the modes and functions of a—> CP. They are set and
downloaded using the NCM S7 configuration tool.

CP

Communications processor. Module for communications tasks.
CSMA/CD

CSMA/CD (Carrier Sense Multiple Access with Collision Detection)
FC

STEP 7 logic block of the type “function”.
Frame

A message from one PROFIBUS/Ethernet station/node to another.

Frame Header

A frame header consists of an identifier for the —> frame and the source and
destination address.
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Frame Trailer

A frame trailer consists of a checksum and the end identifier of the —> frame.

Gateway

Intelligent connectivity device that connects local area—> networks of different
types at the 1ISO Layer 7 level.

Industrial Ethernet
A fieldbus complying with IEEE 802.3 (ISO 8802-2)

NCM S7 for Industrial Ethernet

Configuration software for configuration and diagnostic functions on an Ethernet
CP.

NCM S7 for PROFIBUS

Configuration software for configuration and diagnostic functions on a PROFIBUS
CP.

Network

A network consists of one or more interconnected —> subnets with any number of
—> stations. Several networks can exist side by side.

PG Mode

A mode of the PROFIBUS/Ethernet CP in which the SIMATIC S7-CPU is
programmed, configured or checked via PROFIBUS/Ethernet.
This mode is handled by the S7 functions.

Process Image

The process image is a special memory area in the programmable logic controller.
At the start of the cyclic program, the signal states of the input modules are
transferred to the process input image. At the end of the cyclic program, the
process output image is transferred as a signal state to the output modules.

Protocol

A set of rules for transferring data. Using these rules, both the formats of the
frames and the data flow are specified.
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Segment
Synonym for —> bus segment.
Server
A server is a device, or in general terms, an object that provides certain services. A
service is started at the instigation of a —> client.
Services
Services provided by a communication protocol.
SIMATIC NET

Siemens SIMATIC Network and Communication. Product name for—> networks
and network components from Siemens (previously SINEC).

SIMATIC NET for Ind. Ethernet

SIMATIC NET bus system for industrial applications based on Ethernet
(previously SINEC H1)

SINEC
Previous product name for—> networks and network components from Siemens.
Now: SIMATIC NET
Station
A station is identified by a
e MAC address in the Ethernet network.
¢ PROFIBUS address in the PROFIBUS network.
Subnet

A subnet is part of a —> network whose parameters (for example —> PROFIBUS)
must be matched. It includes the bus components and all attached stations.
Subnets can, for example, be connected together by —> gateways to form a
network.

A —> system consists of several subnets with unique —> subnet numbers. A subnet
consists of several —> stations with unique —> PROFIBUS or MAC addresses
(Industrial Ethernet).
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System

This means all the electrical equipment within a system. A system includes, among
other things, programmable logic controllers, devices for operation and monitoring,
bus systems, field devices, actuators, supply lines.

Transmission Rate

According to DIN 44302, this is the number of binary decisions transmitted per
time unit. The set or selected transmission rate depends on various conditions, for
example the distance across the network. In Ethernet, there is a fixed transmission
rate of 10 Mbps.

Transport Interface

The transport interface of a SIMATIC S5 PLC is the access to the
connection-oriented services of the transport layer on the CP. The transport
interface presents itself to the control program in the form of handling blocks
(HDBs).

Transport Layer

TSAP

Watchdog

The transport layer is layer 4 of the ISO/OSI reference model for open system
interconnection. The purpose of the transport layer is to transfer data reliably from
device to device. Transport connections can be used for the transmission.

Transport Service Access Point

Mechanism for monitoring operability.
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B.2

Ethernet

Base Address

Logical address of a module in S7 systems.
e For PROFIBUS

The PROFIBUS base address is the address starting at which all addresses
that are calculated automatically in the project are assigned.

¢ For Industrial Ethernet

The base MAC address is the address starting at which all addresses that are
calculated automatically in the project are assigned.

ISO-on-TCP

Transport layer connection (layer 4 communication complying with 1ISO) simulated
on TCP.

On an ISO-on-TCP connection, messages can be exchanged in both directions.
TCP provides the data flow communication without segmenting the data into
messages. ISO, on the other hand, is message-oriented. With 1ISO-on-TCP, this
mechanism is simulated on TCP. This is described in RFC1006 (Request For
Comment).

ISO-on-TCP connections allow program/event-controlled communication via
Ethernet from a SIMATIC S7 PLc to

¢ SIMATIC S7 PLC with Ethernet CP
¢ SIMATIC S5 PLC with Ethernet CP
e PC/PG with Ethernet CP

e any system

ISO Transport Connection

B-6

Communication connection of the transport layer (with the CP/COM 143 previously
S5S5 connection).

ISO transport connections allow program/event-controlled communication on
Industrial Ethernet between SIMATIC S7 PLCs and

e SIMATIC S7 with an Ethernet CP

e SIMATIC S5 with an Ethernet CP (e.g. CP 143 or CP 1430)
e PC/PG with an Ethernet CP (e.g. CP 1413)

¢ Any system via the ISO transport protocol (ISO 8073)

The transfer of blocks of data on an ISO transport connection is bi-directional.
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MAC Address

Address to distinguish between different nodes connected to a common
transmission medium (Ethernet).

Media Access Control (MAC)

Mechanisms for controlling access by a station to a common transmission medium
shared with other stations.

RFC 1006
see ISO on TCP

Station (Ind. Ethernet)

A station is identified by a —> MAC address in the —> Ethernet (SINEC H1)
network.

Subnet Mask

The subnet mask specifies which parts of an IP address are assigned to the
network number (see ISO-on-TCP). The bits in the IP address whose
corresponding bits in the subnet mask have the value 1 are assigned to the
network number.

Subnet Number

A —> system consists of several —> subnets with unique subnet numbers.

TCP/IP

TCP = Transport Connection Protocol; IP = Internet Protocol

UDP

User Datagram Protocol: datagram service for simple internetwork transmission
without acknowledgment.

Q
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Linking to Other Systems with C
FETCH/WRITE

The FETCH and WRITE modes supported on ISO transport connections and
ISO-on-TCP connections can be used with any other system to access the S7
system memory areas.

To be able to use this type of access, for example for PC applications, you need to
know the PDU structure of the jobs. The required S7 or S5 header for request and
response frames are 16 bytes long and their structure is described in this chapter.
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Linking to Other Systems with FETCH/WRITE

a) Structure of WRITE Frames

C-2

The meaning and values of parameters shown without values in the following table
can be found in the section “Parameter Values".

WRITE request frame

WRITE acknowledgment frame

0 | System ID ="g” 0 | System ID ="s”
1] ="5" 1 ="5"
2 | Length of header =16d. 2 | Length of header =16d.
3 | ID OP code =01 3 | ID OP code =01
4 | Length OP code =03 4 | Length OP code =03
5 | OP code =03 5 | OP code =04
6 | ORG field =03 6 | Ack field =0Fh
7 | Length ORG field =08 7 | Length S field =03
8 |ORG ID 8 | Error no =No
9 | DBNR 9 | Empty field =FFh
A | Start address High Byte A | Length empty field =07
E Low Byte B
C | Length High Byte |
D] Low Byte D] free
E | Empty field =FFh. E
F | Length empty field =02 ?

Data up to 64 K
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b) Structure of FETCH Frames

The meaning and values of parameters shown without values in the following table

can be found in the section “Parameter Values*.

FETCH request frame

FETCH response frame

C79000-G8976-C129/04

0 | System ID ="g” 0 | System ID ="s”
1 ="5" 1 ="5"
2 | Length of header =16d. 2 | Length of header =16d.
3 | ID OP code =01 3 | ID OP code =01
4 | Length OP code =03 4 | Length OP code =03
5 | OP code =05 5 | OP code =06
6 | ORG field =03 6 | Ack field =0Fh
7 | Length ORG field =08 7 | Length ack field =03
8 |ORG ID 8 | Error no =Nr
9 | DBNR 9 | Empty field =FFh
A | Start address High Byte A | Length empty field =07
E Low Byte B
C | Length High Byte |
D] Low Byte D] free
E | Empty field =FFh. E
F | Length empty field =02 ?
Data up to 64 K but
only if Error no. =0
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Parameter Values

c4

S7 Address Area DB M I Q
ORG ID 01y 02y 034 04y
Source/dest. Source/dest. Source/dest. Source/dest.
data from/to data from/to data from/to data from/to
data block in | flag area process process
main memory image of the | image of the
inputs (PII) outputs (PIQ)
DBNR DB, from irrelevant irrelevant irrelevant
which the
source data
are taken or
to which the
dest data are
transferred
permitted range 1...255
Start address DW number, Flag byte no., | Input byte no., | Output byte
from which from which from which no., from
the data are the data are the data are which the
taken or taken or taken or data are
written to written to written to taken or
written to
permitted range 0...2047 0...255 0...127 0...127
Length Length of the | Length of the | Length of the | Length of the
source/dest. source/dest. source/dest. source/dest.
data field in data field in data field in data field in
words bytes bytes bytes
permitted range 1...2048 1...256 1...128 1...128
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S7 PI/PQ C T
Address Area
ORG ID 054 064 074
Source/dest. Source/dest Source/dest
data from/to in | data from/to data from/to
1/0 modules. counter cells timer cells
With source
data input
modules, with
dest data
output modules
DBNR irrelevant irrelevant irrelevant
Start address 1/0 byte no., Number of the | Number of the

permitted range

from which the
data are taken
or written to

0...127

digital 1/0s
128...255

analog 1/0s

counter cell
from which the
data are taken
or written to

0...255

timer cell from
which the data
are taken or
written to

0...255

Length

permitted range

Length of the
source/dest.
data field in
bytes

1...256

Length of the
source/dest.
data field in
words (counter
cell =1 word)

Length of the
source/dest.
data field in
words (counter
cell = 1 word)
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SIMATIC NET — Support and Training

Customer Support, Technical Support

Open round the clock, worldwide:

Worldwide (Nuremberg)
Technical Support
(FreeContact)

Local time: Mo.-Fr. 7:00 to 17:00
Phone:  +49 (180) 5050-222
Fax: +49 (180) 5050-223

E-mail: techsupport@
ad.siemens.de

GMT: +1:00
Europe / Africa (Nuremberg)
Authorization

Local time: Mo.-Fr. 7:00 to 17:00
Phone:  +49 (911) 895-7200
Fax: +49 (911) 895-7201

E-mail: authorization@
nbgm.siemens.de

GMT: +1:00

Johnson City

T

SIMATIC Hotline

Worldwide (Nuremberg)
Technical Support

(charged only with SIMATIC Card)
Local time: Mo.-Fr. 0:00 to 24:00
Phone: +49 (911) 895-7777
Fax: +49 (911) 895-7001
GMT: +01:00

America (Johnson City) Asia/ Australia (Singapore)

Technical Support and Technical Support and

Authorization Authorization

Local time: Mo.-Fr. 8:00 to 19:00 Local time: Mo.-Fr. 8:30 to 17:30

Phone: +1 423 461-2522 Phone: +65 740-7000

Fax: +1 423 461-2289 Fax: +65 740-7001

E—mail: simat!c.hotline@ E—mail: simat!c.hotline@
sea.slemens.com Sae.slemens.com.sg

GMT: -5:00 GMT: +8:00

The languages spoken on the hotlines are German and English. On the authorization hotline, French, Italian and Spa-

nish are also available.
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SIMATIC NET — Support and Training

Training Center

To help you to become familiar with working with SIMATIC S7 PLCs, we offer a
range of courses. Please contact your regional training center or the central
training center in D 90327 Nuremberg.

Tel. + 49-911-895-3154
Infoline: Tel. +49 180 523 5611 (48 Pfg./min), Fax. 0180 523 5612
Internet: http://ww. ad. si emrens. de/ trai ni ng

E-mail: AD-Training@nbgm.siemens.de

Technical Support Online Services

The SIMATIC Customer Support team provides you with comprehensive additional
information on SIMATIC products in its online services:

¢ You can obtain the latest information
— On the Internet at htt p: / / www. ad. si enens. de/ net
— Using the Fax-Polling no. 08765-93 02 77 95 00

e Current Product Information leaflets and downloads which you may find useful
for your product are available:

— On the Internet at htt p: / / ww. ad. si enens. de/ csi / net

— Via the Bulletin Board System (BBS) in Nuremberg (SIMATIC Customer
Support Mailbox) at the number +49 (911) 895-7100.

To access the mailbox, use a modem with V.34 (28.8 Kbps) capability whose
parameters you should set as follows: 8, N, 1, ANSI, or dial in using ISDN
(x.75, 64 Kbps).

Further Support

If you have further questions about SIMATIC NET products, please contact your
local Siemens representative.

You will find the addresses:
e In our catalog IK PI

¢ On the Internet (http://www.ad.siemens.de)
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Access coordination, 5-20
Address parameters
broadcast, 4-52
unspecified 1ISO-on-TCP connection, 4-32
unspecified TCP connection, 4-41
unspecified UDP connection, 4-51
AS-Interface,|1-2

B
Broadcast, with UDP, 4-49

C

Communication options, 1-3

Communication services, configuring, 2-16

Configuration data, downloading to the PLC,
2-17

Connection, properties, 4-4

Connection configuration,|4-3

CP address, 5-2

CP configuration data, saving, 2-18

Creating a subnet, 2-4

CSMA/CD, 1-2

D

Diagnostics, 2-12
Displaying network attachments, 2-8
Dynamic properties, 4-21

E

Ethernet, overview,|1-2
Ethernet CP
further CP properties, 2-10
time, 2-11
installing and starting,|2-1
procedure,|2-3

F

FCs for access coordination with
FETCH/WRITE,|5-20
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FETCH/WRITE services
configuration for 1SO-on-TCP, 4-33
configuration for 1ISO transport, 4-23
configuration for TCP, 4-42
overview, 1-15

Firmware Loader, 7-1
application,|7-2
loading firmware,|7-3

Functions
AG-RECV, 3-2,13-4
AG-SEND, 3-2,/3-4

Functions (FCs)
AG_LOCK, 5-22
AG_LOCK / AG_UNLOCK, 5-20
AG_RECV / AG_LRECV, 5-15
AG_SEND / AG_LSEND, 5-10
AG_UNLOCK,|5-24
block number,|5-2
for configured connections, 5-7
general notes, 5-2
typical sequence,|3-5

Further functions, 4-11

H

Hardware configuration, Ethernet CP,|2-6

Industrial Ethernet, overview,|1-2
ISO transport connection, 4-15
amount of data and number of connections,
4-4
checking, 4-25
connection without assignment, 4-12
dynamic properties, 4-21
printing configured connections, 4-11
properties dialog, 4-15
addresses, 4-19
dynamics, 4-21
general,[4-16
overview, 4-25
save connection, 4-11
unspecified connection, 4-20
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ISO-on-TCP connection
addresses, 4-30
checking, 4-35
properties, 4-27
specifying the partner, 4-28

J
Job header, 5-8

N

NCM S7
general information, 2-2
installation, 2-2

NCM S7 Diagnostics, 6-1
overview,|6-2

Network access,|1-2

New connection, 4-7, 4-8

O

Operator interface devices, 1-9,/1-10
Other station, 1-16, 4-9

configuring, 2-13

connecting a subnet, 2-14

P

PG operation
with STEP 7 on Ethernet,|1-8
with STEP 7 via Ethernet, 1-6
PG/PC interface, 1-10
PROFIBUS, 1-2
Project variant
1 subnet — 1 project, 1-18

1 subnet — more than 1 project, 1-21
2 or more subnets — 1 project, 1-20
more than 1 subnet — more than 1 project,

1-22

several subnets several projects, 1-23
SIMATIC S5 and non-SIMATIC devices,

1-19

Index-2

R

Routing,|4-56

S

S7 communication on Ethernet, 1-3, 1-10
S7 communication relay, 1-3,/1-10
S7 functions, 1-3
SEND/RECEIVE interface, 1-3
CPU cycle,|3-7
data exchange, 3-2
overview, 1-12
user program, 3-4
SIMATIC NET, 1-2
System memory, access using
FETCH/WRITE, 4-24,/4-34, 4-43

T

TCP connection,|4-36
addresses, 4-39
checking properties, 4-44
specifying the partner, 4-37
Type of communication, 1-3

U
UDP

addresses, 4-49

checking, 4-53

configuring, 4-46

specifying connection partners, 4-47
Unspecified connection,|4-9
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